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INTRODUCTION 
 
Procedure development is an ongoing process. Consult the DNA Technical Leader for significant changes to any 
of the following procedures or for developing additional procedures. Proposed changes shall be reviewed by 
those affected by this manual prior to incorporation. Allowances (non- significant changes) may be made for 
adapting procedures (e.g. volume, tube size/type, spin times, incubation times) to accommodate unusual 
samples and situations. Allowances to adapt a standard procedure are a recognized part of lab work, as they 
may be necessary to meet the requirements of certain samples. These deviations must be scientifically sound 
and shall be documented in the case file. 
 
The standard method of analysis of DNA conducted by the Washington State Patrol CODIS Crime Laboratory 
(WSPCCL) for the convicted offender database is by the analysis of Short Tandem Repeat (STR) regions by 
Polymerase Chain Reaction (PCR). The WSPCCL examines 27 loci: the original Combined DNA Index System 
(CODIS) 13 core loci (CSF1PO, FGA, TH01, TPOX, vWA, D3S1358, D5S818, D7S820, D8S1179, D13S317, D16S539, 
D18S51, and D21S11); the expanded CODIS core loci (D1S1656, D2S1338, D2S441, D10S1248, D12S391, 
D19S433, and D22S1045); Amelogenin and DYS391 for sex discrimination; Penta D, Penta E, and SE33 for 
increased discrimination; and rapidly mutating Y STR loci DYS570 and DYS576. 
 
PCR is a method used for the amplification of a specific DNA segment whereby two oligonucleotides (primers) 
anneal to opposite strands and flank a DNA region to be copied. The synthesis reaction is repeated for a number 
of cycles and results in the exponential accumulation of the specified DNA segment, the termini of which are 
defined by the 5’ ends of the primers used in the reaction. 
 
EXTRACTION 
 
DNA suitable for PCR-based typing is currently obtained by the QIAGEN EZ1® Advanced XL and EZ1® DNA 
Investigator® Kit, a semi-automated process which uses paramagnetic resin to capture DNA. 
 
HUMAN DNA QUANTITATION 
 
The Applied Biosystems (AB) Quantifiler™ kits provide reagents and protocols necessary for the rapid and 
sensitive quantitation of human nuclear DNA. The role of the Quantifiler™ Human kit is to detect and quantify 
total human DNA. The genomic targets are PCR amplifiable sequence tagged sites on the human telomerase 
reverse transcriptase (hTERT) locus of chromosome 5. The procedure is quantitative PCR (qPCR) and is based on 
the real-time detection of a 5’ fluorescent reporter dye that is cleaved and separated from a 3’ non-fluorescent 
quencher incorporated on a DNA probe during PCR amplification. Also included in the kit is an internal PCR 
control (IPC) consisting of a non-naturally occurring DNA sequence that can detect the presence of PCR 
inhibitors. The qPCR is performed in the AB 7500 Real-Time PCR System instrument. 
 
AMPLIFICATION 
 
STR PCR amplification is performed using the AB GeneAmp® PCR System 9700 thermal cycler or the AB ProFlex™ 
PCR System. The polymerase used requires heat activation. This has the advantage that the enzyme is not active 
during the setup of the samples. The formation of “primer dimers” is avoided and there is no time constraint 
placed upon the setup procedure. To activate the enzyme, the thermal cycler protocol includes a “hot start” at 
the beginning of the amplification process. 
 
Three steps are involved in each amplification cycle. First, the template DNA is made single-stranded by heat 
denaturation. In the second step, the temperature is lowered so that annealing of the oligonucleotide primers to 
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the template may occur. This interaction is favored because, initially, the ratio of primer to template is large. 
Annealing of the PCR primers to the template DNA is responsible for the technique’s high level of specificity. 
Under optimized conditions, annealing of complementary DNA strands (primers) should only occur at those sites 
on the template flanking the region to be amplified. In this way, a sequence of several hundred bases can be 
selected from a background of, in the case of human DNA, 3 x 109 base pairs. In the third step, the temperature 
is raised to a point that favors both specific annealing of the primers and extension by the DNA polymerase. 
These three steps are repeated over and over again to achieve a sufficient quantity of amplified product. The 
target DNA is amplified at an exponential rate if one assumes a 100% efficient PCR reaction. Even when carefully 
controlled, a PCR reaction is rarely, if ever, 100% efficient. 
 
The DNA polymerase adds an extra nucleotide (usually adenosine) to the end of a strand of DNA. If this reaction 
only occurs partially, then DNA of two lengths, differing by one base pair, will be produced from the same 
template and primers, causing the appearance of a split peak. Having amplified product of uniform size is 
important in STR analysis, as it is the length of the final product that is detected. A length variance of one base 
pair is detectable by the system, and therefore undesirable. To avoid this, the addition can either be prevented 
or conditions chosen so virtually all the amplification product is converted. Since the latter is easier, a 10-minute 
soak at 60°C is included at the end of the polymerization cycles to drive the addition reaction to completion. 
 
Kits that contain all of the necessary components to amplify and detect Amelogenin and the 20 CODIS core loci 
are commercially available. It is possible to detect and distinguish the products of several loci amplified 
together. This is referred to as multi-component analysis. The PowerPlex® Fusion 6C kit allows for the co-
amplification and detection of the 20 core loci, in addition to Amelogenin, Penta D, Penta E, SE33, DYS391, 
DYS570, and DYS576. This kit also allows for either the direct amplification of sample punches in PCR master 
mix, or for the amplification of DNA extracts with known concentrations. 
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Fusion 6C Kit Loci 
Locus Approx. Size Range (bp) Dye Color 

Amelogenin 80 – 89 Blue (FL-6C) 

D3S1358 90 – 151 Blue (FL-6C) 

D1S1656 152 – 209.5 Blue (FL-6C) 

D2S441 211 – 252 Blue (FL-6C) 

D10S1248 254 – 302.5 Blue (FL-6C) 

D13S317 304.5 – 357 Blue (FL-6C) 

Penta E 362 – 482 Blue (FL-6C) 

D16S539 74 – 129.4 Green (JOE-6C) 

D18S51 130 – 217.5 Green (JOE-6C) 

D2S1338 221.5 – 304 Green (JOE-6C) 

CSF1PO 313 – 366.5 Green (JOE-6C) 

Penta D 373.5 – 470 Green (JOE-6C) 

TH01 65 – 118 Yellow (TMR-6C) 

vWA 121 – 192 Yellow (TMR-6C) 

D21S11 197 – 266.5 Yellow (TMR-6C) 

D7S820 268 – 315.5 Yellow (TMR-6C) 

D5S818 317.5 – 380 Yellow (TMR-6C) 

TPOX 390 – 448 Yellow (TMR-6C) 

D8S1179 66 – 129.8 Red (CXR-6C) 

D12S391 130.1 – 190.5 Red (CXR-6C) 

D19S433 192 – 255 Red (CXR-6C) 

SE33 270 – 429 Red (CXR-6C) 

D22S1045 430 – 478 Red (CXR-6C) 

DYS391 79.5 – 131 Purple (TOM-6C) 

FGA 134 – 299 Purple (TOM-6C) 

DYS576 302 – 370 Purple (TOM-6C) 

DYS570 380 – 464 Purple (TOM-6C) 

Internal Size Standard 60 – 500 Orange (WEN-6C) 

 
DETECTION 
 
Multicomponent Analysis 
Multicomponent analysis uses two separate properties to distinguish between loci: length variance and 
fluorescent labels. 
 
Length Variance 
The amplified product from each locus will vary in length, dependent upon the number of repeats found in a 
particular STR. By careful selection of primers, it is possible to produce amplified products for several loci, all of 
which fall into discrete size ranges. Thus a particular locus can be identified by the size of its alleles. 
 
Fluorescent Labels 
Different fluorescent labels can be attached to the primers used in the amplification process. The emission 
spectra of these labels are sufficiently different such that the contribution made by each label in a mixture can 
be calculated both quantitatively and qualitatively. Thus, even if two separate DNA fragments co-migrate, they 
can be differentiated by their fluorescent labels. 
 
By careful selection of both primers and fluorescent dyes, several different co-amplified loci can be distinguished 
based both upon their fluorescence and the size of the fragment lengths. Amplification kits are designed such 
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that each dye employed detects loci in discrete size ranges, along with one dye reserved as an internal size 
standard. 
 
Genetic Analyzers (CEs) 
There are several instruments commercially available that will separate DNA fragments based upon their size 
and fluorescent labels. These instruments separate fragments using capillary electrophoresis. A window in the 
capillary is continually illuminated by a laser. As fragments of DNA with fluorescent labels pass by the window, 
they are excited and the resulting emitted light is collected and analyzed. 
 
The WSPCCL currently uses AB 3500xL Genetic Analyzers. 
 
Internal Size Standards 
An appropriate internal size standard is added to each sample prior to electrophoresis. The internal size 
standard consists of several amplified fragments of DNA, all of which have been sequenced and are of known 
length. The migration time of each fragment is recorded and this data is used to calculate an estimated length 
for the other DNA fragments that are detected. 
 
INTERPRETATION OF RESULTS 
 
The data generated is analyzed using the software program, GeneMapper® ID-X, available from Applied 
Biosystems. 
 
This program converts the raw data from AB Genetic Analyzers into discrete peaks, assigns a size to those peaks 
based upon their estimated length in base pairs, and converts the estimated fragment sizes in base pairs to 
designated alleles by comparing the fragment sizes to the known alleles in a standard called an allelic ladder. 
The program also displays that data in the form of an electropherogram. 
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CODIS CASE APPROACH 
 
Quality in the CODIS Laboratory is maintained using the Crime Laboratory Division (CLD) Quality Operations 
Manual, the DNA Quality Assurance Manual, the FBI’s DNA Quality Assurance Standards, and following the 
protocols in this manual. 
 
ADMINISTRATIVE PROCESSING GUIDELINES 
 
All convicted offender samples received in the laboratory are processed following the guidelines of the 
Administrative Processing of Convicted Offender Samples procedure. Convicted offender samples are collected 
by hundreds of collectors across Washington State using kits provided by the CODIS Laboratory. Kits are 
assembled in-house, and requests for these kits are handled by CODIS Laboratory staff. A detailed spreadsheet 
of kit requests is maintained by CODIS staff. 
 
Completed kits are received through the mail or hand-delivery. Prior to acceptance by the lab, each completed 
kit is evaluated by a CODIS staff member. Information accompanying the DNA sample is assessed for 
completeness and accuracy. When a question arises about any of the submitted information, verification is done 
using the offender’s criminal history record, court records, and/or contacting the collecting agency, prosecutor’s 
office, or other law enforcement entity. Any information obtained using these sources is documented on the 
submission card along with the origin of the information and the date and initials of the individual recording the 
information. If a question arises about the quality of a sample, recollection can be requested. An electronic log is 
maintained of all rejected samples. 
 
Each sample is assigned a unique laboratory number and is referenced only by that number thereafter. The 
electronic Convicted Offender Entry Form is used for data entry into LIMS. By using the SID of the convicted 
offender when entering data, the entry program is able to verify whether or not a DNA sample has already been 
received for that individual and will auto-populate the electronic entry form with the individual’s name and date 
of birth. For any sample that is determined to be a duplicate, the request generated upon entry of the sample is 
automatically cancelled. Cancelled samples are retained, but are not typically typed unless needed for a hit 
confirmation or as a quality control check. For any sample without a SID, every attempt is made to determine if 
one exists. If one does not exist, the sample is entered manually using an acceptable alternative identification 
number (see the Administrative Processing of Convicted Offender Samples procedure for more details). When a 
non-duplicate sample is entered with a SID, the criminal history record of that individual is updated to indicate a 
sample has been received. 
 
A barcode for each sample is generated once the sample has been entered into LIMS. Barcode labels are applied 
to any individual component of the sample submission. 
 
Once processed administratively, offender samples are stored in a secure location in the CODIS Laboratory until 
ready to be typed. 
 
LABORATORY PROCESSING GUIDELINES 
 
All laboratory work is conducted following the procedures in this manual and the CLD DNA Quality Assurance 
Manual. Any deviation from laboratory procedure is documented in the case file and approved by the DNA 
Technical Leader or designee. The CODIS supervisor and technical lead are designated by the DNA Technical 
Leader with the authority to approve acceptable minor (non-significant) deviations of STR interpretation 
guidelines and protocols. Before results may be released, peer review of a completed file is conducted in 
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accordance with the CLD Quality Operations Manual, this manual, and the DNA Quality Assurance Manual by a 
qualified DNA CODIS analyst. 
 
The date on top of the page following the Run Folder Review sheet is the date a sample set was started, usually 
the date samples were punched or prepared for extraction. The analyst will record the date the case file was 
completed and reviewed by the analyst prior to technical review on the last page of the case file. Any changes 
made to the case file as the result of technical review will be documented with the analyst’s initials and date to 
document that the change was made after the analysis complete date. For electronic records that do not 
automatically track changes, a note will be written in the case file describing the change, initialed, and dated. 
 
As a quality control measure, sets may contain random reanalysis samples. These are known duplicate 
submissions for existing samples that were previously typed. The goal random reanalysis sample amount is five 
percent of samples per completed samples in a year. Random reanalysis samples may also include hit 
confirmation samples. 
 
Convicted offender DNA samples are typically first processed in a 96-well plate format using direct amplification. 
Samples are punched into amplification plates with an automated puncher. The puncher includes a barcode 
reader, which scans each unique sample barcode and associates the sample with a specific well. When the 
barcode is unreadable, the sample number may be hand- entered. This sample to well association is maintained 
through analysis on a CE by copying the puncher-generated worklist data directly into an Excel workbook that 
automatically creates a CE template. The sample to well association is documented in the case file by saving the 
worklist tab as a PDF. 
 
After amplification and running the samples and controls on a CE, the resulting data is analyzed using 
GeneMapper ID-X. This software is used to record information about samples that pass, but have quality flags or 
anomalies that the analyst must assess. The analysis method used in the software is dependent on the 
amplification method (i.e. direct vs. non-direct) or PCR cycle number. 
 
Samples that do not pass after the first round of analysis are re-tested using a method appropriate for the 
quality issue observed in the sample. Appropriate controls must also be run. 
 

• PCR product can be diluted using TE buffer or injected for different times. 
 

• As a quality control measure, manual manipulations from a 96-well plate to another plate or tube shall 
be witnessed when there is not sufficient genetic information in the first-pass data for comparison. The 
witness will document any steps observed by initialing and dating the applicable worksheet. 

 

• Samples may be direct amplified again, and may use a different combination of cycle number, punch 
quantity, and amplification volume. PunchSolution reagent may be used in conjunction with direct 
amplification for pre-treating weak buccal samples. 

 

• Samples may also be extracted, quantitated, and amplified. Extracts can be cleaned up or combined and 
concentrated using Microcon filters in cases where samples are extremely weak or show signs of 
inhibition. 

 
A manual punch can be used in lieu of the automated puncher when the batch of samples needing to be 
processed is reasonably small (e.g. samples that are being re-tested or a hit confirmation set). 
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When labeling tubes, the analyst will do so either behind a shield, with a mask, or in a hood to prevent 
contaminating the tubes with their own DNA. 
 
When a sample is consumed, this will be indicated on the outside of the sample card or envelope, along with the 
date and analyst’s initials. 
 
The samples are returned to the storage area once the analyst is done working with them. 
  
Sample Tracking 
CODIS analysts assign samples to themselves in LIMS prior to administrative review. In most cases, a LIMS 
worklist is made for each set of samples processed and a barcode identification of the LIMS worklist is 
automatically generated. Following peer review, a mass-marking program allows the analyst to input the LIMS 
worklist barcode and enter the set number for Case Info, a result for Findings Entered, and the technical and 
administrative reviewers. Running the program updates each sample in the worklist with the input information. 
 
For small sets of samples, tracking samples in LIMS may be done without a LIMS worklist. After assigning 
samples to themselves and analysis is complete, a result is added to Findings Entered, the set number is added 
to the Case Info tab, and the milestone is set to Draft Complete for each individual sample. The technical and 
administrative reviewers must also update the corresponding milestones when review is complete. 
 
Once samples are marked “Admin Reviewed” in LIMS, any samples with SID numbers have the DNA Typed flag 
on the criminal history record updated. 
 
Failed Samples 
If a full profile is not generated for a sample after consuming the entire sample, the sample is considered to 
have failed. The request is cancelled in LIMS. A note about the sample failing or being SDIS-only is entered into 
the Notes field of the Case Info tab. If a duplicate is available that has not been typed, the analyst will un-cancel 
the request and type the duplicate sample at their next available opportunity. If the sample does not have a 
duplicate, the corresponding criminal history record is updated to reflect a “no” result for the DNA Taken and 
Typed fields. The collecting agency or other law enforcement entity is contacted to see if the individual is still 
incarcerated to recollect the sample. Whether or not a sample can be recollected and the source of the 
information is documented on the Run Folder Review worksheet. When an agency agrees to recollect a sample, 
the information is recorded on an electronic log for recollection requests. It is the responsibility of the individual 
requesting sample recollection to follow up with an agency to ensure recollection occurred. 
 
FILE STORAGE 
 
Files associated with the in-house typing of convicted offender samples as well as files and disks associated with 
the review of samples typed by a contract laboratory will be stored on site for at least two years. After two years 
these files may be archived to the Washington State Archive Center in Olympia. The convicted offender data 
sheet or data card will be retained by the CODIS Laboratory indefinitely. 
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QUALITY ASSURANCE/QUALITY CONTROL 
 
DNA EXTRACTION AREAS 
 

• All solutions used in DNA extraction are prepared according to the protocols in the Reagent Preparation 
section of this manual. 

• All glassware to be used in preparation of critical reagents will be autoclaved. If a solution itself is to be 
autoclaved, the glassware used in its preparation need not be autoclaved beforehand. Pipette tips and 
microcentrifuge tubes that are sterilized (as in the manufacturing process) need not be autoclaved. 

• Gloves will be worn where appropriate. 

• Instruments used to cut or handle stains (scissors, forceps, scalpels, Harris punch) should be cleaned 
before each use. 

• Use filtered pipette tips when pipetting any solutions. 

• Care should be exercised when inserting pipettes into reagent containers. Stock reagents should be 
poured from the reagent bottle into a smaller container from which pipetting should be done. Avoid 
touching the container with the barrel of the pipette. 

• The work area should be cleaned after each use with 10% bleach or other appropriate cleaner. 

• The interiors of microcentrifuges should be cleaned periodically. 

• All non-sterile plates and tubes will be autoclaved and UV irradiated prior to use. 
 
PCR SET-UP AREA 
 

• Gloves will be worn when working in the PCR set-up hoods. 

• Set up PCR according to protocol. Use only the pipettes dedicated to the PCR set-up area. Use sterile, 
filtered pipette tips. Dispose of pipette tips in a waste container in the hood. 

• The hood will be cleaned on a regular basis with a 10% bleach solution (or other appropriate cleaner) 
and then rinsed with water (if using bleach). Pipette barrels will also be wiped regularly with a 10% 
bleach solution (or other appropriate cleaner). Additionally, the UV light in the hood (if so equipped) will 
be utilized after each use of the hood. 

• All non-sterile plates and tubes will be autoclaved and UV irradiated prior to use. 
 
POST-AMPLIFICATION AREAS 
 

• All solutions used in the post-amplification areas are prepared according to the reagent manual 
protocol. 

• Gloves will be worn where appropriate. 

• Only dedicated lab coats will be worn when working in this area. 

• Handling of PCR products will be done with dedicated pipettes and filtered pipette tips. 

• If bench top protective paper is used, it will be changed at least weekly. 

• Any PCR product or other items contaminated with PCR product will be discarded in the appropriate 
container in the post-amplification areas. 

• PCR product may only be stored in a dedicated refrigerator or freezer. 
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CONTROLS AND STANDARDS 
 
Reagent Blank 
A reagent blank will be prepared each time a set of DNA samples is extracted, and must be extracted 
concurrently with the corresponding samples. The reagent blank will be prepared like the other samples being 
extracted, except no source of DNA will be added to this sample. Any generated reagent blank shall be amplified 
using the same primers, instrument model, and concentration conditions as required by the sample(s) 
containing the least amount of DNA. The amplified reagent blank shall be typed using the same instrument 
model, injection conditions, and most sensitive volume conditions of the extraction set. 
 
In accordance with FBI QAS Standard 9, if multiple reagent blanks are used within an extraction set, each 
reagent blank shall be quantified and at least one shall be amplified if any of the specimens associated with the 
extraction set will be amplified. If multiple reagent blanks are used and quantified with an extraction set, at 
minimum, the reagent blank that demonstrates the greatest signal, if any, shall be amplified and characterized. 
 
When concentrating samples where a single extraction generated multiple reagent blanks, only one of those 
reagent blanks is required. The reagent blank taken forward should be one that, if formerly quantified, 
demonstrated the greatest signal, if any, unless that reagent blank was already demonstrated to be 
contaminated. 
 
If the reagent blank associated with the extraction set or sample being amplified is depleted, an analyst shall not 
continue. The volume of sample amplified cannot exceed that of its reagent blank. 
 
Internal Laboratory Control 
The internal laboratory control is a sample from a known individual within the laboratory system who does not 
work in the CODIS Laboratory. This control is not required, but, when used, it should be treated as a regular 
sample. Every attempt should be made to get the control to successfully genotype, but if it is the only sample 
delaying the completion of a set, testing may cease with an explanation provided in the case file. 
 
Should a positive amplification control fail, an internal laboratory control that is run in the same amplification 
may be used in its place to demonstrate the amplification worked as expected. 
 
Positive and Negative Amplification Controls 
At the amplification step, two extra tubes containing the amplification master mix will be prepared. To one tube 
the appropriate volume of positive control DNA will be added, and to the other an equal volume of TE or 
Amplification Grade Water will be added. 
 
A positive and negative amplification control will be included in every set of amplifications conducted and the 
negative control will be processed under the same conditions as the positive control. 
 
For direct amplification reactions, the negative amplification control is considered a combined reagent blank and 
negative amplification control. It shall be typed using the same instrument model, injection conditions, and most 
sensitive volume conditions used for the samples in the batch. 
 
Internal Size Standards 
An appropriate internal size standard will be included with every sample prepared to be run on the CE. The data 
collected from this standard will be used to verify the quality of a particular injection and also be used to 
estimate the size of any DNA fragments present in the run. It is essential to have the data from this standard in 
order to process samples in the GeneMapper® ID-X program. 
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Allelic Ladder 

An appropriate ladder will be included with every set of samples run on the CE. A passing allelic ladder is 

essential in order to process samples in the GeneMapper® ID-X program. 

 
QUALITY CONTROL OF REAGENTS 
 
The following critical reagents shall be evaluated prior to use: 

• QIAGEN EZ1® DNA Investigator® kit 

• QIAGEN Buffer MTL 

• TE 

• Applied Biosystems Quantifiler™ Human kit 

• Promega G147A  

• Promega PowerPlex® Fusion 6C kit 

• Promega PunchSolution™ kit 
 
REAGENT QUALITY CONTROL TESTING 
 
Unless a quality control procedure indicates otherwise, a known DNA sample is used to perform the QC of a new 
lot number of reagent or kit before it may be used on convicted offender samples. The known DNA sample must 
be analyzed using the current laboratory protocols. The known DNA sample must type correctly and meet all 
data analysis parameters as required in the current laboratory protocols. If the sample does not type correctly or 
does not meet the analysis parameters, the reagent or kit may not be used for convicted offender analysis until 
the problem is resolved. 
 
Scientifically valid exceptions pertaining to meeting the analysis parameters for reagent testing can be made if 
approved by the CODIS supervisor in consultation with the DNA Technical Leader. The successful completion of 
the QC is documented on the reagent or kit and on the appropriate QC worksheet. All QC testing will be verified 
by another CODIS scientist to ensure that analysis parameters are met, the paperwork is filled out correctly, and 
the electronic data is present. This verification will be documented on the QC worksheet, which will then be 
saved as a PDF and stored with the electronic data. 
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PERFORMANCE CHECK AND CALIBRATION OF INSTRUMENTS 
 
Routine maintenance procedures are described by instrument/equipment elsewhere in this manual (see Table 
of Contents). A maintenance item does not necessarily have to be performed on-schedule for an instrument that 
isn’t being used at the time the maintenance is due. The operator will ensure all necessary maintenance items 
are performed prior to use. If annual maintenance is required of an instrument, it is not necessary to perform it 
within the year if the instrument is taken off-line. 
 
The performance check and/or calibration of instruments demonstrates they are working properly and will 
produce the expected results. Performance checks will be conducted at least annually, and for critical 
instruments after calibration, maintenance, or repair. Written documentation of calibrations and performance 
checks will be maintained in the CODIS laboratory. 
 

• pH meters will be calibrated with known pH standards according to the manufacturers’ instructions 
before they are used. 

 

• Balances will be checked at least annually by an external provider. 
 

• For each refrigerator/freezer/oven/water bath/heat block, variance should be established as per the 
Equipment Calibration and Maintenance section of the DNA Analysis Quality Assurance manual. If, when 
the temperature is checked, the equipment is functioning outside that range, use of the equipment in 
forensic testing should be stopped immediately and measures taken to return the equipment to 
function within its accepted range. 

 

• The operating temperature of refrigerators, freezers, and any other storage unit or area used to store 
reagents or samples that would degrade if not maintained at or below a given temperature will be 
recorded each working day or monitored using the TempGenius system. 

 

• The operating temperature of ovens, water baths, or other apparatus that is used to maintain a constant 
temperature of reagents or a reaction should be checked each working day, prior to its use, or 
monitored using the TempGenius system. 

 

• Semiannually, the thermometers/probes used to record these temperatures will be verified against a 
NIST traceable thermometer. The thermometer/probe can remain in service if it is within 

• ± 4° C of the NIST traceable thermometer. Alternatively, a thermometer can be used that is NIST 
traceable and certified for a specific time period as long as it is replaced or re-certified before that 
period has expired. 

 

• The operating temperatures of heat blocks for direct amplification pre-treatment and for 
denaturing/snap-cooling amplification product do not require daily recording of temperatures. The 
thermometers of these units will be semiannually verified against a NIST traceable thermometer as 
described above. 

 

• NIST traceable thermometers will be re-certified annually by an appropriately qualified external agency. 
Alternatively, disposable NIST traceable thermometers may be used until their expiration date. 

 

• Thermal cyclers are a critical instrument and will be performance checked semi-annually using the 
appropriate temperature probe and the directions provided by the manufacturer of the thermal cycler. 



Washington State Patrol Crime Laboratory Division 

CODIS Lab STR Procedures Manual 

 

 
CODIS Lab STR Procedures Page 14 of 69 Revision January 1, 2024 

Approved by CLD Quality Manager All Printed Copies are Uncontrolled Revision 35 

 

 

• Annually, the probes used to check the calibration of thermal cyclers will be re-certified by an 
appropriately qualified external agency.  

 

• Pipettes will have their calibration checked annually by a qualified external agency. 
 

• The following instruments and equipment are considered critical and will be performance checked prior 
to use in convicted offender sample analysis and following maintenance or repair by qualified 
technicians. All except NIST-traceable thermometers require annual performance checks (see details 
above for equipment maintenance, and further below for instrument maintenance). The annual 
calibration of pipettes (detailed above) is considered the required performance check and no additional 
evaluation is needed prior to use. 

 
o BSD600 Duet Puncher 
o BSD600 Ascent Puncher 
o QIAGEN EZ1 Advanced XL 
o AB 7500 Real-Time PCR Systems 
o AB GeneAmp PCR System 9700 thermal cyclers 
o AB ProFlex PCR System 
o AB 3500xL Genetic Analyzers 
o Pipettes 
o NIST-traceable thermometers 
o Incubators 
o Heat blocks 
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PROCESSING OF CONVICTED OFFENDER SAMPLES 
 
DNA samples received by the CODIS Laboratory are treated as reference materials. 
 
Buccal samples on FTA paper (from a WSP provided kit) from convicted offenders are collected and submitted to 
the laboratory by law enforcement facilities, courts, etc. In rare instances, blood samples are drawn instead. It 
has been requested that these samples be submitted in EDTA vacutainer tubes, accompanied by a collection 
card from the WSP provided kit. Paraffin embedded tissue (PET) samples from deceased offenders may also be 
submitted. 
 
On receipt, each whole blood sample is prepared as follows: 
 

1. Approximately 50 – 75 µL of blood is pipetted onto each of two FTA circles of a collection card. This may 
be stored at room temperature along with standard buccal on FTA samples. Alternatively, ten to twelve 
75 µL stains are prepared on Schleicher & Schuell 903 paper or other clean filter paper. The stains are 
air-dried, sealed in plastic bags, and frozen at -20°C to -80°C, pending analysis. 

 
2. Any remaining whole blood is destroyed by pouring into a disinfectant solution.  

 
DNA typing of the convicted offender blood samples is done using a portion of one of the prepared 75 
µL bloodstains. Similarly, DNA typing of convicted offender buccal samples is done using a portion of the 
submitted FTA card. PET samples are processed using shavings from the embedded tissue. 
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EZ1® DNA INVESTIGATOR® KIT EXTRACTION 
 
This method is for DNA extraction from buccal samples on FTA® paper, blood stains on filter paper, and paraffin-
embedded tissue (PET) samples typically provided as samples from convicted offenders. This method may also 
be used for swabs, foam applicators, and gauze or other cloth materials. The sample undergoes lysis/digestion 
or pre-treatment to prepare it for DNA extraction on the QIAGEN EZ1 workstation. 
 
The DNA Investigator Card for the EZ1 workstation has three validated DNA purification procedures to select 
from depending on the desired application: the Tip Dance Protocol, the Trace Protocol, and the Large Volume 
Protocol. All protocols can accommodate a cutting from FTA paper, filter paper, or other substrates such as 
swabs. The cutting size may vary as long as it is covered by G2 buffer. When processing PET samples, a modified 
Large Volume protocol is recommended. Steps for this protocol are detailed separately. 
 

• Tip Dance Protocol: for processing solid materials directly in the sample tube, with a starting volume up 
to 300 µL. There is generally no need for prior centrifugation to remove solid materials that could clog 
the tip. However, it is recommended to remove fluffy sample material. Note that this protocol will not 
recover the lysate absorbed by the sample substrate. 

• Trace Protocol: for processing samples with limited DNA, with a starting volume up to 300 µL. A tube 
basket assembly is required following the pretreatment step, and a lower elution volume (40 or 50 µL) is 
recommended. 

• Large Volume Protocol: for processing samples with limited or dilute DNA (e.g. diffuse stains) with a 
starting volume up to 500 µL. A tube basket assembly is required following the pretreatment step, and a 
lower elution volume (40 or 50 µL) is recommended. 

 
An extraction batch may include up to 28 samples (two full runs) on the EZ1. If two EZ1 workstations are 
required for an extraction batch, the instruments must be run concurrently and a reagent blank must be 
included on at least one of the concurrently run instruments. 
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GENERAL PROTOCOL 
 

1. Place the sample into an appropriate tube based on the EZ1 protocol being used: 

• Tip Dance: 2 mL sample tube provided in Investigator kit 

• Trace & Large Volume: 2 mL sample tube that accommodates a basket insert 
 

2. Add a sufficient volume of G2 buffer (190-290 μL for Trace or Tip Dance, 475 μL for Large Volume only) 
to cover the sample.  
 

3. Add 10 μL (Trace or Tip Dance) or 25 µL (Large Volume) proteinase K and mix thoroughly by vortexing. 
 

4. Incubate at 56°C for 30 minutes up to overnight. Longer incubation times can be used for low level DNA 
content samples while the shorter incubation times can be used for higher level DNA content samples.  
 

5. If needed, flick the tube or pulse spin to remove droplets from inside the lid. If a tube basket assembly is 
used, place the substrate into a basket insert and place the insert back into the tube. Spin at maximum 
speed in a microcentrifuge for 2 minutes. Discard the basket and transfer the liquid to a 2 mL sample 
tube provided in the Investigator kit. Alternatively, if using a 2 mL basket tube assembly that can be 
loaded on the EZ1, discard the basket and cut off the tube lid prior to loading.  
 

6. For the Large Volume protocol, add 400 µL Buffer MTL and 1 µL carrier RNA (1 µg/µL) to each sample 
(this may be done by making a master mix). For the Tip Dance and Trace protocols, 1 µL carrier RNA may 
be added, but is not required. 
 

7. Make sure the DNA Investigator protocol card is fully inserted in the EZ1 and turn the instrument on. 
 

8. Press “Start” to display the “Protocols” menu. Select the desired protocol and follow the screen prompts 
to select the appropriate conditions for the samples being processed and to set up the worktable. 

• Ensure elution tubes are labeled correctly 

• Select elution in TE buffer 

• Invert reagent cartridges twice and tap to return reagents to the bottom of their wells before 
placing on the instrument. 
 

9. Press “Start” to begin the purification procedure, which takes approximately 15 – 20 minutes. 
 

10. When the protocol ends, “Protocol finished” will be displayed. Retrieve and re-cap the elution tubes. 
The DNA extract is ready for immediate use or can be refrigerated or stored frozen long-term. 
 

11. Remove and discard the disposable labware. Follow the cleaning procedure as prompted on the screen 
and outlined in the QIAGEN EZ1 Maintenance procedure in this manual. A 20 minute minimum UV 
decontamination step will be selected following the cleaning procedure. 

• Due to the chaotropic salts present in the cartridges, do not dispose of them in any bleach or 
container which may contain bleach as cyanide gas may result. 
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MODIFIED LARGE VOLUME PROTOCOL FOR PARAFFIN-EMBEDDED TISSUE (PET) SAMPLES 
 

1. Shave 1-2 small pieces off from the tissue block, taking care to avoid white waxy sections, into an 
appropriate 1.5-2.0 mL tube. A spin basket is not required for this protocol. 
 

2. Add 450 μL of G2 buffer to the sample tube. 
 

3. Add 25 μL proteinase K to the sample tube and mix thoroughly by vortexing.  
 

4. Incubate at 56°C overnight. Add an additional 25 μL of proteinase K (for a total of 50 μL) to the sample 
tube approximately 5 hours after initially placing the tube in the incubator.  
 

5. Pre-heat a heat block to 90°C. Place samples directly from incubator onto heat block and incubate for 1 
hour.  
NOTE: Tube top may need to be re-enforced with parafilm to ensure the tube does not open during this 
step. 
 

6. After incubation, if needed, flick the tube or pulse spin to remove droplets from inside the lid. Then 
allow samples to briefly sit at room temperature to cool. 
 

7. If wax from a PET sample is visible after samples have cooled either on the sides of the tube or is layered 
at the top of the lysate or there is remaining undigested tissue visible, transfer the lysate to a clean tube. 
 

8. Add 400 μL MTL Buffer and 1 μL carrier RNA (1 μg/μL) to each sample (this may be done by making a 
master mix).  
 

9. Follow steps of General Protocol starting at step 7 for the remainder of sample extraction on the EZ1.   



Washington State Patrol Crime Laboratory Division 

CODIS Lab STR Procedures Manual 

 

 
CODIS Lab STR Procedures Page 19 of 69 Revision January 1, 2024 

Approved by CLD Quality Manager All Printed Copies are Uncontrolled Revision 35 

 

MICROCON® CONCENTRATION OF DNA 
 
This procedure can be used to combine and concentrate weak extracts or to clean up extracts that show signs of 
inhibition (e.g. poor amplification of the IPC during quantitation, ski slope effect in the electropherogram). When 
using a Microcon, the associated reagent blanks shall be processed concurrently with the sample(s). The 
Microconned reagent blank will be named using the date of the procedure. 
 

1. Assemble a Microcon® Fast Flow concentrator unit. To the top of the concentrator, add 30-100 µL TE, if 
desired. Transfer the DNA extracts to be concentrated to the top of the concentrator. The total volume 
of extract and TE added to the sample reservoir should be no more than 500 µL. 

 
2. Cap the concentrator and spin in a centrifuge at ~500 to 5000 x g for about 10-15 minutes or longer 

(settings can be adjusted according to centrifuge type and sample viscosity). 
 

3. Carefully remove the concentrator unit from the assembly and discard the filtrate fluid from the filtrate 
vial. Return the concentrator to the top of the filtrate vial. 

 
4. Add 200 µL TE to the concentrator. Recap and spin the assembly in the centrifuge for ~10 minutes at 

~500 to 5000 x g. 
 

NOTE: Additional washes may be required to remove inhibitors that may be present and should be done 
on samples of extremely limited quantity. If the Microcon is being used to just concentrate or reduce 
sample volume, the addition of TE as a wash step is not necessary. 

 
5. Remove the cap, if adding TE; add the desired final volume of TE to the concentrator. 

 
6. Remove the concentrator from the filtrate vial and carefully invert the concentrator onto a new labeled 

retentate vial. Discard the filtrate vial. 
 

7. Centrifuge the assembly at 1000 x g for ~5 minutes (or pulse briefly). 
 

8. Discard the concentrator. Cap the retentate vial. 
 
Samples are ready for human DNA quantitation. Use samples immediately for PCR or refrigerate samples for 
storage while the sample is actively being worked (avoid repeated freeze-thaw cycles). Freeze samples for long 
term storage. Prior to use for PCR, vortex and pulse spin samples. 
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QUANTIFILER® TEMPLATE SETUP 
 
Prior to quantitation, a Quantifiler® template is set up and used to assign an imported plate document with the 
appropriate cycling conditions, dyes, reaction volume, and analysis settings. 
 

1. Open the 7500 Software and select Advanced Setup from the main window. 
 

2. Select Experiment Properties. Add the name of the 7500 Software version in the Comments field. Ensure 
that the following properties are selected: 

a. 7500 (96 Wells) 
b. Quantitation – Standard Curve 
c. TaqMan® Reagents 
d. Standard (~2 hours to complete a run) 

 
3. Select Plate Setup: 

a. Rename “Target 1” as “Sample”. Ensure the Reporter dye is “FAM” and the Quencher is set to 
“None”. 

b. Add a new target and rename it “IPC”. Ensure the Reporter dye is “VIC” and the Quencher is set 
to “None”. 

 
4. Select Run Method and set the following parameters: 

a. Reaction Volume Per Well: 10 µL 
b. Holding Stage 

• Step 1: 95.0°C for 10:00 
c. Cycling Stage (Number of Cycles = 40, do not Enable AutoDelta) 

• Step 1: 95.0°C for 00:15 

• Step 2: 60.0°C for 01:00 
 

5. Select Analysis → Analysis Settings. Select each target (“Sample” and “IPC”) and set the following 
parameters: 

a. Uncheck Default CT Settings 
b. Uncheck Automatic Threshold. Set the Threshold to 0.2. 
c. Uncheck Automatic Baseline. Set the Baseline Start Cycle to 6, and the End Cycle to 15. Select 

Apply Analysis Settings 
 

6. Select File → Save As Template. Save as “QF template”. 
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QUANTIFILER® REACTION PREPARATION AND 7500 SETUP 
 

1. Calculate the volumes of Quantifiler® PCR Reaction Mix (5.3 µL per sample/standard) and Primer Mix 
(4.5 µL per sample/standard) needed to prepare the reaction master mix. 

 
2. Thaw the Primer Mix completely, vortex 3 to 5 seconds and pulse spin briefly before opening the tube. 

 
3. Swirl the PCR Reaction Mix gently before using. Do not vortex. 

 
4. Pipette the calculated volumes of components into an appropriately sized tube. 

 
5. Vortex the master mix for 3 to 5 seconds, then pulse spin briefly. 

 
6. Obtain a 96-well reaction plate and seat in the optical support base. The reaction plate shall not be 

rested on any surface without the base. The plate shall not be touched on the bottom of the wells. 
 

7. Dispense 9.2 µL of the master mix into each reaction well of the reaction plate. 
 

8. Add 0.8 µL of sample, standard, or control to the appropriate well of the reaction plate, as determined 
by the plate setup sheet. 

 
9. Seal the reaction plate with an optical adhesive cover. Care shall be taken not to touch the cover. The 

plastic applicator shall be used to seal the cover to the reaction plate. Drag the applicator across the 
cover several times to ensure a proper seal. Seal around the edges and remove the white strips from the 
cover. 

 
10. Centrifuge the plate as necessary to eliminate bubbles. 

 
11. Open the 7500 and place the 96 well plate in the precision holder with well A1 in the upper left corner. 

Push the tray closed. 
 

12. Open the 7500 Software and select Template from the main window. Select “QF template”. 
 

13. Select File → Import. Browse for and select the desired plate document (txt). 
 

14. Select Start Import. When prompted for continuing with the import, select Yes. 
 

15. Verify that the plate layout appears as it should, and that all quantitation parameters are appropriate. 
 

16. Select File → Save As. Save the file (eds) in a designated results folder 
 

17. Select Start Run. 
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QUANTIFILER® DATA ANALYSIS AND INTERPRETATION 
 
The AB Quantifiler® Human DNA Quantification Kit and 7500 Real-Time PCR System are used to determine the 
amount of PCR amplifiable human DNA. The results can aid in determining whether inhibition is present in a 
sample, if sufficient DNA is available for STR analysis, and how much DNA to target for amplification. 
 

1. Open the completed .eds quantitation file and verify the Run Method and Analysis Settings are correct 
(see Quantifiler® Template Setup). 

 
2. Under the Analysis menu, select Standard Curve. All 8 standards must have amplified for the curve to 

pass. Review the following values: 
 

a. Slope: indicates amplification efficiency 
Typical Validated Range: -3.0 to -3.7 
Average:   -3.3 
Ideal (100% efficiency):  -3.32 
 
If the slope is outside the determined range then a check of the assay setup, software setup, 
reagents, and instrument may be appropriate. Document that the slope is outside of the 
validated range and that results should be used with caution. 
 

b. R2: measures the closeness of fit between the standard curve regression line and the individual 
CT data points of the standards. An R2 value greater than 0.98 is desirable. If R2 is less than 0.98, 
consider the preparation and efficacy of the quantitation standards. Document that R2 is less 
than 0.98 and that results should be used with caution. 

 
3. Under the Analysis menu, select Amplification Plot to review the Internal PCR Controls (IPCs). The IPCs in 

the assay monitor for the presence of PCR inhibitors and may indicate when sample reprocessing is 
necessary. The normal CT (threshold cycle) for an IPC should range from 20 to 30. 

 

Sample/Standard (FAM dye)  IPC (VIC dye)  Interpretation 

No amplification Amplification True Negative 

No amplification No amplification Cannot distinguish between inhibition and absence of DNA 

High concentration with low CT No amplification IPC efficacy may be suppressed by high DNA concentration 

Weak amplification with high CT No amplification Partial PCR inhibition 

 
4. In the Amplification Plot section, click on View Well Table tab to review the sample quantitation results. 

The Quantity column displays concentration in ng/µL. 
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BSD600 DUET PUNCHER PROTOCOL 
 
The BSD600 Duet Puncher punches 1.2 mm discs from dried sample cards (buccal and blood samples on FTA or 
filter paper) and deposits them into 96-well plates for direct amplification. The software creates an electronic 
worklist that is used for sample tracking. 
 
CREATING A TEST 
 
Tests serve as templates for standard punching protocols. Multiple tests can be created in advance for different 
needs, such as full plates of convicted offender samples or proficiency tests. 
 

1. Launch the BSD600 Duet Software and log in to display the main menu. 
 

2. Click on Configure System. Ensure that: 
a. File tab: the desired worklist format is selected. 
b. Punching tab: number of cleaning strikes and number of samples between cleaning are set to 1. 

 
3. Click on the Edit Test Sequences button, then Create a new test. Select the appropriate Plate definition 

in the dialog box (Microtitre.tray for a 96-well plate). 
 

4. Select Test > Test configuration. Click on each tab: 
a. Position settings may be set based on user preference. 
b. Automatic filling should be enabled, beginning at the top left corner and filling vertically. Wells 

per sample should be set to 1. 
c. Spot per Well should be set to 1 for each small punch sample type and 0 for each large punch 

sample type. 
d. Plate Barcodes should be left empty or set to allow any type of barcode. 
e. End Controls should be set to 0. 

 
5. Wells are set to contain Samples by default. To change the type of well, double click and select the 

desired sample type from the menu. Select Leave Empty for any wells that should not contain a punch. 
 

6. Select Test > Standard & control names. If desired, different standards and controls may be given more 
specific names. 

 
7. An additional plate may be added to the test from the Plates menu if needed. 

 
8. Save the test using a unique name. 
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OPERATING THE PUNCHER 
 

1. Perform before-use maintenance. 
 

2. Turn on the humidifier, ideally 30 minutes prior to punching. A longer time (e.g. 60 minutes) should be 
considered when the air is especially dry. This step is performed to mitigate static within the puncher 
operating chamber. 

 
3. If samples are to be punched into a reagent for direct amplification (such as PunchSolution or 

amplification master mix), add reagent to the plate(s). 
 

4. Turn on the instrument and vacuum system. 
 

5. Launch the BSD600 Duet Software and log in. 
 

6. Select the Distribute Spots Program option and choose an appropriate test. 
 

7. To further reduce static, use an ionizing instrument (e.g. anti-static gun) on the plate and platform 
within the puncher operating chamber. 

 
8. Load plate(s) after the puncher moves into position, as directed by the software. 

 
9. If desired, turn on the Auto-trigger and set to a time interval comfortable for the user. Alternatively, the 

foot switch may be used to activate the punching process. 
 

10. Scan the barcode of the first sample to be punched, which will be displayed on the computer screen. If a 
sample does not have a barcode, the sample number can be typed into the software. Controls are pre-
named based upon the test chosen. 

 
11. Slide the card beneath the card clamps so that the red light targeting pattern can be seen on the card. 

This indicates the precise position from which a disc will be punched. 
 

12. Move the card to the desired punching location. If the Auto-trigger is turned on, the punching process 
will occur automatically based on the user-set time interval. Otherwise, push the foot switch to activate 
punching. 

 
13. After the punch has been deposited in the plate, the software will prompt the user to punch a filter 

paper waste punch following the same process. 
 

14. The punching cycle is repeated until all samples for a test are punched. 
 

15. Remove plates from the puncher. 
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BSD600 ASCENT PUNCHER PROTOCOL  
 
The BSD600 Ascent Puncher punches 1.2 mm discs from dried sample cards (buccal samples on FTA and blood 
samples on FTA or filter paper) and deposits them into 96-well plates for direct amplification. The software 
creates an electronic worklist that is used for sample tracking. 
 
CREATING A TEST  

Tests serve as templates for standard punching protocols. Multiple tests can be created in advance for different 
needs, such as full plates of convicted offender samples or proficiency tests.  
 

1. Launch the BSD600 Ascent Studio Software and log in. 
 

2. On the main screen, select ‘Test Editor’ and then ‘Add’. Enter an appropriate, unique test name and 
ensure ’96 Well PCR’ is selected for plate type and ‘Full’ for fill pattern. Click save. 
 

3. Select the newly created test name from the thumbnails displayed to view the plate map and edit the 
test. 
 

4. Select ‘Plate information’ and ensure that the Barcode matching string is set to the default (?*) to allow 
for plate naming during punching. 
 

5. Select ‘Punch settings’ to set the number of punches per well by sample type. Confirm the punch size is 
set to 1.2 mm and either 1 or 2 punches may be selected for the left sample value. It is recommended 
the remaining values be set to zero. 
 

6. Select ‘Well types’ to assign sample types to wells. By default, wells are set to Samples. For wells 
reserved for allelic ladders and amplification controls, select either Liquid control or Unused, then click 
on the desired wells; this will ensure nothing is punched into these wells. Click on ‘Plate edit’ to return 
to the plate map. 
 

7. Select ‘Fill ordering’. These settings may be changed as needed, but the following settings are 
recommended: Wells per sample is set to 1, Fill start position is set to ‘Top left,’ Fill direction is set to 
‘Vertical’, and only ‘Samples’ is checked. 
 

8. On the plate map, click on a well to show Well properties. If desired, more specific names for standards 
and controls may be entered here in the Barcode field. The well type and number of punches may also 
be edited here. 
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OPERATING THE PUNCHER 
 

1. Perform before-use maintenance.  
 

2. Turn on the instrument, ideally at least 2-5 minutes before punching. This also turns on the instrument’s 
humidifier and ionizer systems if both pumps are set to ‘on’ in the Settings. This step is performed to 
mitigate static within the puncher operating chamber. To further reduce static, an ionizing instrument 
(e.g. anti-static gun) may be used on the plate and platform within the puncher operating chamber. 
 

3. If samples are to be punched into a reagent for direct amplification (such as PunchSolution or 
amplification master mix), add reagent to the plate(s).  
 

4. Turn on vacuum pump prior to punch run. 
 

5. Launch the BSD600 Ascent Studio Software and log in. Select Profile Editor from the main screen, then 
Instrument settings and ensure that the Ionizer and Humidifier pump run speeds are set to ‘Medium’. 
One of these pumps may be adjusted to ‘High’ if static issues are encountered during punching. 
 

6. Select Punch from the main screen. On the left side of the screen, select a deck position and select a 
desired pre-made test from the drop down. Click Close. Ensure that Cleaning is toggled on and under 
Edit both ‘Samples between cleaning punches’ and “Number of cleaning punches’ is set to 1. Select Start 
Punch Run. 
 

7. Press Scan barcodes to enter the set name. Load plate(s) after the puncher moves into position, as 
directed by the software 
 

8. If desired, turn on the Auto-trigger and set to a time interval comfortable for the user. Additional details 
for Auto-trigger use are found in the User Manual.  
 

9. The software will prompt the user to punch a waste punch. 
 

10. Scan the barcode of the first sample to be punched, which will be displayed on the computer screen. If a 
sample does not have a barcode, the sample ID can be typed into the software. Controls are pre-named 
based upon the Test chosen.  
 

11. Slide the card beneath the card clamps so that the red light targeting pattern can be seen on the card. 
This indicates the precise position from which a disc will be punched. Use the foot switch, touch screen, 
or Enter key to activate the punching mechanism. Alternatively, if the Auto-trigger is turned on, the 
punching process will occur automatically based on the user-set time interval. The well camera should 
show the disc(s) deposited in the well. 
 

12. Steps 9-11 are repeated until all samples for a test are punched. When punching is complete, select End 
Punch Run.  
 

13. Remove plate(s) from the puncher and exit the software.  Shut down vacuum pump and instrument.   
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FUSION 6C DIRECT AMPLIFICATION 
 
Direct amplification can be used for buccal and blood samples on FTA or filter paper. 1.2 mm punches from 
blood samples will be pre-treated with PunchSolution to maximize the amount of DNA available for 
amplification. An appropriate PCR cycle number should be chosen based on the sample type being amplified. 
Because only one or two punches are used for direct amplification, the reactions are highly dependent on 
sampling, especially for non-uniform buccal on FTA samples. For re-testing, punch quantity, cycle number and 
reaction volume can be varied to obtain a useable profile. In general, increasing punch quantity or cycle number 
results in higher peaks, while a larger reaction volume tends to produce a more balanced profile. For very weak 
samples, the analyst should consider alternative case approaches, such as pre-treatment with PunchSolution 
before direct amplification, direct amplification of two 1.2 mm buccal sample punches, or concentrating DNA 
extracts for a standard amplification. 
 
 
PRETREATMENT WITH PUNCHSOLUTION 
 
This protocol will be used for all blood samples, and may be used for troubleshooting weak buccal samples. 
Pretreatment of typical buccal samples on FTA is not recommended, as severe profile imbalance may result (i.e. 
allele dropout at larger loci). 
 

1. Dispense 10 µL PunchSolution into each tube/well, including the negative amplification control. Exclude 
any positive amplification control tubes/wells. 

 
2. Place one 1.2 mm punch per sample into each tube/well with at least one waste punch between 

samples and incubate at 70°C for 30 minutes or until tubes/wells are dry. The tube/plate must be left 
uncovered for evaporation to occur. For buccal samples, two 1.2 mm punches per tube/well may also be 
used. 

 
3. Proceed with the preparation and addition of PCR master mix for direct amplification. 

 
 
DIRECT AMPLIFICATION SET UP 
 

1. Prepare the components of the Fusion 6C amplification kit. 
 

a. At first use, thaw the 5X Master Mix, 5X Primer Pair Mix and Amplification Grade Water 
completely. After first use, store at 2 – 10°C. 
 

b. Centrifuge the 5X Master Mix and 5X Primer Pair Mix tubes briefly to bring the contents to the 
bottom, then vortex the reagents for 15 seconds before each use. Do not centrifuge after 
vortexing, as this may cause a concentration gradient. 
 

c. Vortex and briefly spin the 5X AmpSolution Reagent. If the reagent is turbid, it may be warmed 
slightly at 37°C, then vortexed until clear. 
 

d. Appropriately dilute the 2800M positive control (+C) DNA with Amplification Grade Water so 
that 1 µL of +C solution contains the desired DNA target (for a typical buccal sample control). 
2800M is provided at 10 ng/µL. Suggested targets: 
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Sample Type Target 

Buccal 2 ng 

Blood 5 ng 

 
2. Determine the number of reactions to set up (# samples = n), including positive and negative controls. A 

5% buffer is included in the amount of each reagent to compensate for volume loss during pipetting. 
 

Component Half Volume Full Volume 

Amplification Grade Water 5.25 µL x n 10.5 µL x n 

5X Master Mix 2.63 µL x n 5.25 µL x n 

5X Primer Pair Mix 2.63 µL x n 5.25 µL x n 

5X AmpSolution Reagent 2.63 µL x n 5.25 µL x n 

 
3. Set up the amplification. Preparation and dispensing of PCR reagents should be performed in a biological 

hood or other area designated for PCR set up. 
 

a. Prepare the master mix using the table in step 2. 
 

b. For samples not pre-treated with PunchSolution: 
i. Vortex master mix for 5 – 10 seconds and dispense into each tube/well – 12.5 µL for the 

half volume reaction or 25 µL for the full volume reaction. 
ii. Place one or two 1.2 mm punches per buccal sample into each tube/well containing 

master mix with at least one waste punch between samples. This step should be 
performed in an extraction workstation or automated puncher. 
 

c. For samples pre-treated with PunchSolution: 
i. Following the PunchSolution 70°C incubation/evaporation step, vortex master mix for 5 

– 10 seconds and dispense into each tube/well – 12.5 µL for the half volume reaction or 
25 µL for the full volume reaction. 
 

d. Vortex and spin the diluted 2800M DNA, then add 1 µL (for a typical buccal sample control) to 
any positive control tubes/wells. 

 
4. Seal or cap the tubes/plate and, if needed, briefly centrifuge to bring the punches and master mix to the 

bottom. 
 

5. Load the tubes/plate onto a thermal cycler and start the appropriate amplification protocol.  
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THERMAL CYCLING PROTOCOL 
 
All ProFlex protocols must be set up using 9700 Simulation Mode. For the 9700, ensure that Max Mode is 
selected for ramp speed and the correct reaction volume is input. 
 

96°C for 1 minute, then: 
 
96°C for 5 seconds 
60°C for 1 minute 
for desired # of cycles, then: 
 
60°C for 10 minutes 
4°C for ∞  

Reaction Volume Sample Type Cycle # 

12.5 µL 
Buccal 24 – 27 

Blood 23 – 25 

25 µL 
Buccal 24 – 26 

Blood 23 – 25 
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FUSION 6C EXTRACT AMPLIFICATION 
 
The target amplification range of template DNA is approximately 0.125 ng to 4.0 ng based on quantification 
results. For samples below this DNA target amount, the analyst should consider alternative case approaches, 
such as combining and concentrating DNA extracts. 
 

1. Prepare the components of the Fusion 6C amplification kit. 
a. At first use, thaw the 5X Master Mix, 5X Primer Pair Mix and Amplification Grade Water 

completely. After first use, store at 2 – 10°C. 
b. Centrifuge the 5X Master Mix and 5X Primer Pair Mix tubes briefly to bring the contents to the 

bottom, then vortex the reagents for 15 seconds before each use. Do not centrifuge after 
vortexing, as this may cause a concentration gradient. 

c. Appropriately dilute the 2800M positive control (+C) DNA with Amplification Grade Water or TE 
buffer to the desired template amount. 2800M is provided at 10 ng/µL. 

d. A negative amplification control (-C) will be run with every amplification. The –C will be 
prepared using either Amplification Grade Water or TE buffer depending on which reagent was 
used to normalize the samples being amplified. 

 
2. Determine the number of reactions to set up (# samples = n), including controls. A 5% buffer is included 

in the amount of each reagent to compensate for volume loss during pipetting. 
 

Component Volume 

5X Master Mix 5.25 µL x n 

5X Primer Pair Mix 5.25 µL x n 

 
3. Set up the amplification. The following steps should be performed in a biological hood or other area 

designated for PCR set up. 
a. Prepare the master mix using the volumes above. Vortex for 5 – 10 seconds and dispense 10 µL 

into each tube. 
 

b. Add 15 µL of DNA extract and 2800M DNA diluted to the desired target with either amplification 
grade water or TE buffer to the appropriate tubes. Add Amplification Grade Water or TE buffer 
to the negative amplification control tube. 

 
4. Load the tubes onto a thermal cycler and start the appropriate amplification protocol.  

 
THERMAL CYCLING PROTOCOL 
 
All ProFlex protocols must be set up using 9700 Simulation Mode. For the 9700, ensure that Max Mode is 
selected for ramp speed and the correct reaction volume is input. 
 

96°C for 1 minute, then: 
 
96°C for 5 seconds 
60°C for 1 minute for 29 cycles, then: 
 
60°C for 10 minutes 
4°C for ∞  
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AMPLIFICATION PRODUCT PREPARATION FOR THE 3500XL 
 
Formamide is a teratogen – wear gloves. 
 

1. Prepare a mixture of Hi-Di™ Formamide and WEN ILS 500. A lower volume of WEN will decrease the 
intensity of size standard peaks. 

 

Mixture Example 

[(9.75 µL formamide) x # samples] + [(0.25 µL WEN) x #samples] 1000 µL formamide + 25.6 µL WEN 

[(9.5 µL formamide) x # samples] + [(0.5 µL WEN) x #samples] = standard 1000 µL formamide + 52.6 µL WEN 

[(9.25 µL formamide) x # samples] + [(0.75 µL WEN) x #samples] 1000 µL formamide + 81.1 µL WEN 

[(9.0 µL formamide) x # samples] + [(1.0 µL WEN) x #samples] 1000 µL formamide + 111.1 µL WEN 

 
2. Vortex for 10 – 15 seconds and spin briefly. If making a stock tube, label with the WEN lot number, date 

of preparation, and analyst’s initials. 
 

3. Dispense 10 µL of formamide/WEN mixture to the appropriate wells of the CE plate. 
 

4. Add 1 µL of PCR product or allelic ladder to each well. PCR product may be diluted with TE buffer up to 
1:20 as needed. 

 
5. Cover the plate with a septum and spin briefly to remove bubbles. 

 
6. Denature samples at 95°C for 3 minutes, then snap-cool for 3 minutes. 

 
7. Place the plate in a plate base and cover with a plate retainer. 
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RUNNING PLATES ON THE 3500XL GENETIC ANALYZER 
 

1. On the Dashboard of the 3500 Series Software, click the ‘Start Pre-Heat’ button to turn on the oven. 
 

2. Complete any maintenance that is required. 
 

3. With the instrument door closed, push the tray button to bring the autosampler forward. Place any 
plates to be run on the autosampler. When the door is shut, the autosampler should return to its home 
position. 

 
4. Navigate to the Main Workflow portion of the 3500 Series Software to create a new plate or import a 

plate from a template. The following parameters must be applied to each plate: 
 

a. Assay: 6sec_F6C, 12sec_F6C, 18sec_F6C, 24sec_F6C 
b. Results Group: CODIS 
c. File Name Convention: CODIS 

 
5. On the ‘Load Plate for Run’ screen, verify that any plates on the instrument are linked correctly and start 

the run. 
 

6. Wait until the ‘Monitor Run’ screen is displayed before leaving the instrument. Error messages (ex. 
expired reagent installed, not enough POP-4 remains for all injections, etc.) may appear before this 
screen is displayed; the run will not proceed until the messages are acknowledged. 
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GENEMAPPER® ID-X SETUP 
 
The following procedure applies primarily to ID-X users with Admin profile access and shall be applied to any 
Server copy of ID-X. All users will set up project options and CODIS table export settings on their ID-X Clients. 
 
If an individual user name has not been created, log in as user “gmidx”. Otherwise, log in using the individual 
user name. Once an Admin profile user has been created, any changes to the software shall be done from that 
profile to maintain a more accurate audit trail record. 
 
SETTING UP A USER ACCOUNT 
 

1. Open Security Manager 
2. Select the appropriate user account type: 

a. For an administrator, select Databasing Tech Lead 
b. For an analyst, select Databasing Analyst 

3. Select Edit > Duplicate 
4. In the name field, change the name to the CODIS login of the individual the account applies to. 
5. Enter the full name of the individual under Full Name in the User Details section. 
6. Select Pre-Expire for the password to prompt the new user to create a password upon their first login. 
7. Select Set Password and create a generic password for the new user. 
8. Select File > Save 

 
For custom user groups, user accounts, or security groups, follow the steps as outlined in the GeneMapper ID-X 
Administrator’s Guide. Additional information about editing users can also be found in the Administrator’s 
Guide. Only an Admin level user with the input of the CODIS supervisor, technical lead, and/or the DNA 
Technical Leader may make these changes. 
 
After any changes are made in the Security Manager, a copy of the settings should be exported as a backup. If 
more than one Server exists, the settings shall be imported to that computer to ensure they are the same (see 
the GeneMapper ID-X Administrator’s Guide for instructions on exporting and importing security settings). 
 
SETTING UP THE AUDIT TRAIL CONFIGURATION 
 

1. Open the ID-X software 
2. Choose Admin > Audit Manager > Setting 
3. Log in to Audit Manager 
4. Choose “Allele” from the left navigation pane 

a. Set “deleted” and “created” to “on” 
b. Set “modified” to “silent” 

5. Choose “Sample” from the left navigation pane 
a. Set “deleted”, “OverrideSQ”, “modified, and “created” to “off” 
b. Set “OverrideGQ” and “OverrideCGQ” to “silent” 
c. Set “ALLELE” to “on” 
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SETTING UP THE ANALYSIS METHOD FOR CONVICTED OFFENDER ANALYSIS 
 

 
DIRECT AMPLIFICATION 

(≤ 26 cycles) 
DIRECT AMPLIFICATION 

(≥ 27 cycles) 
NON-DIRECT 

AMPLIFICATION 

1. Open GeneMapper ID-X Manager 

2. Select the Analysis Method tab and click New 

3. Select the General tab and enter the following: 

a. Name: 
F6C_3500xL_GF_280_ 

<implementation date> 
F6C_3500xL_GF_500_ 

<implementation date> 
F6C_3500xL_ 

<implementation date> 

b. Security Group: Databasing Security Group 

c. Instrument: 3500xL 

4. Select the Allele tab and enter the following: 

a. Bin Set: PowerPlex_Fusion_6C_Bins_IDX_v1.2 

b. Use marker-specific stutter ratio and 
distance if available 

checked 

c. Global Cut-off Values set Tri, Tetra, and Penta to 0.15 All set to 0.0 

d. Ensure all other values are set to 0.0. 

5. Select the Peak Detector tab and enter the following: 

a. Ranges: Analysis: Full Range Sizing: Partial Sizes, 60 – 500 

b. Smoothing and Baselining: Light Smoothing; 51 pts Baseline Window 

c. Size Calling Method: Local Southern Method 

d. Peak Amplitude Threshold: 120 for all dye colors 

e. Min. Peak Half Width: 2 pts 

f. Polynomial Degree 3 

g. Peak Window Size 15 pts 

h. Slope Threshold: start and end at 0.0 

i. Normalization unchecked 

6. Select the Peak Quality tab and select the following: 

a. Homozygous min peak height: 280 500 500 

b. Heterozygous min peak height: 120 

c. Max Peak Height (MPH): 50000 

d. Min peak height ratio: 0.6 

e. Max peak width: 1.5 

f. Max expected alleles: 2 for autosomal and AMEL 1 for Y markers 

g. Allelic Ladder Spike: Enable detection Cut-off value: 0.2 

h. Sample Spike Detection Enable 

7. Select the SQ & GQ Settings tab and enter the following: 

a. AMEL Cross Check (ACC): 0.5 

b. Do not alter the remaining default settings 

8. Save the analysis method. 
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SETTING UP PROJECT OPTIONS 
 
1. From the Project Window, go to File > Project Options. 
2. Select the General tab and choose the following: 

a. Under Project, check Open Blank Project 
b. Under Data Access Control, select Databasing Security Group 

3. Select the Add Samples tab and choose the following: 
a. Set Analysis Method to: Current Analysis Method 
b. Set Size Standard to: WEN_ILS_500_CS 
c. Set Panel to: PowerPlex_Fusion_6C_Panels_IDX_v1.2_<implementation date> 

4. Select the Analysis tab and choose the following: 
a. Under Analysis Summary check: 

i. Stop analysis and display Analysis Requirements Summary 
ii. Stop analysis and display Allelic Ladder Analysis Summary 

iii. View Analysis Summary 
b. Under Quality Metrics Display, check Symbols 

5. Click OK to save the Project Options. 
 
IMPORTING LAB REFERENCE AND CUSTOM CONTROL PROFILES 
 
1. From the Project Window, open the run folder containing the desired profile 
2. Go to the Samples tab and ensure the Sample Name is the desired custom name for the reference or control 
3. Select the sample and go to Tools > Add Profile > Lab Reference (in the case of a reference) or Custom 

Control (in the case of a control) 
4. Click Close in the Add Profile Results dialogue box to save the profile 
 
CODIS TABLE EXPORT SETTINGS 
 
1. Go to Tools > CODIS Export Manager 
2. Under Source Lab IDs, enter the source lab and select add 
3. Under Destination Lab IDs, enter the destination lab and select add 
4. Click OK 
5. Navigate to the CODISMarkers file and ensure that all loci in the amplification kit being used are included. 

Refer to GeneMapper ID-X Software Help for details on location and editing of the file. 
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EVALUATING FUSION 6C PROFILES WITH GENEMAPPER® ID-X V1.6.2 AS AN 

ANALYSIS TOOL 
 
The following guidelines are provided for evaluating convicted offender DNA typing profiles obtained by STR 
analysis using PowerPlex Fusion 6C, an AB Genetic Analyzer, and GeneMapper ID-X. 
 
DATA ANALYSIS WORKFLOW 
 
Creating a Project in ID-X 
1. In the new Project window, select Add Samples to Project. Under the Files tab, navigate to the desired run 

folder, then click Add to List followed by Add. 
2. In the Project window, select the desired view from the Table Settings drop-down menu. 
3. In the Samples tab, ensure that the correct Sample Type, Analysis Method, Panel, and Size Standard are 

selected. Select a custom control, if applicable. 
4. Click the Analyze (green arrow) button and complete the fields in the Save Project dialog box. Click OK to 

save the project. 
NOTE: Should any of the samples be inadvertently misnamed, the above steps will be completed prior to re-
naming the sample in ID-X. This ensures that the edit will be documented in the sample’s Info tab in the 
software. 

5. In the navigation pane, expand the run folder, select the Raw Data tab, and scroll through each sample. 
Verify the presence of primer peaks in all samples. The raw data may also aid in the evaluation of anomalies 
and causes of poor sizing quality. 

 
Quality Assessment & Documentation in ID-X 
GeneMapper ID-X analyzes CE data and assists the analyst in evaluating sample quality through a system of 
process quality values (PQVs). These PQVs may be either sample- or marker-level and are associated with color-
coded flags that are triggered when a sample does not meet the quality requirements defined in the software. 
The PQV results are displayed as: 
 

■ Pass (green square)  

▲ Check (yellow triangle)  

● Low Quality (red octagon)  
 
Evaluate the quality flags to help determine whether a sample may be accepted or requires additional testing. 
Once deemed acceptable, a system of peak edits and marker-level Genotype Quality (GQ) flag overrides is used 
to document analyst review of the sample. 
 
Peak Edits: Select the peak, then right-click and select Rename Allele Label. Identify artifacts using the pre-
defined list or the Custom Artifact Label; artifact labels will appear in pink boxes in the electropherogram. True 
alleles requiring re-naming (e.g. microvariants) will be edited using the Custom Allele Label. Each edit is tracked 
in the software. 
 
Genotype Quality PQVs: Once all edits are complete for a locus, select the marker in the Genotypes table, right-
click, then select Yes in the dialog box to override the GQ. The GQ PQV will turn into a passing flag and all other 
PQVs for the marker will turn gray and retain their original shape. When all GQs have been overridden for a 
sample, the user will be prompted to override the Composite Genotype Quality (CGQ). Select No. 
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Samples that do not pass will remain in the run folder to aid technical review, but do not need to be analyzed 
using peak edits and GQ overrides.  
 
DATA EVALUATION & INTERPRETATION 
 
All samples and controls shall be examined, regardless of the PQV flags. 
 
An analysis method using a global filter will leave peaks that are equal to or less than an assigned cut-off value 
unlabeled. The cut-off value is the percentage of a given peak to the highest peak in the same locus or, if a given 
peak is outside of a locus, to the highest peak in the same dye channel. Data evaluated with this method will be 
assessed for anomalous results. 
 
Data that does not satisfy the following evaluation and interpretation requirements is considered to be 
uninterpretable. 
 
Raw Data 
Examine the raw data. Typically, the primer peak should rise and fall abruptly and the baseline should be flat and 
smooth. If the primer peak trails excessively or the baseline is elevated, negatively affecting genotyping quality, 
the sample should be re-injected. 
 
WEN Internal Lane Standard 
The size standard data in each sample will be examined. If the Sizing Quality (SQ) PQV flag is yellow or red, the 
data should be inspected to confirm that all of the peaks are present and correctly labeled. All size standard 
peaks must be above the analytical threshold and within the analysis range. Other quality issues, such as broad 
peaks, may be accepted at analyst discretion if genotyping quality is not adversely affected. 
 
Allelic Ladder 
An appropriate allelic ladder will be included in every run folder. All ladders will be reviewed and any flagged 
ladders will be evaluated to determine if the failure was due to a factor that may have affected the 
corresponding injection. ID-X does not use flagged ladders for data analysis. 
 
Controls 
All controls will be reviewed by the analyst. It may be appropriate for the analyst to override PQV flags 
depending on the type of quality issue. 
 

• Reagent Blank: No forensically significant PCR product should be detected in the reagent blank. The reagent 
blank shall be amplified using the same primers, instrument model, and concentration conditions as 
required by the sample(s) containing the least amount of DNA. The amplified reagent blank shall be typed 
using the same instrument model, injection conditions, and most sensitive volume conditions of the 
extraction set. 

 

• Positive Amplification Control (+C): Confirm that the genotype is correct and no forensically significant 
contamination is present. The +C is not subject to confirmation of peak height imbalances. When multiple 
+Cs exist for an amplification, only one must pass. 

 

• Negative Amplification Control (-C): No forensically significant PCR product should be detected in the -C. It 
must be loaded and injected under at least the same sensitivity conditions as the corresponding +C. For 
direct amplifications, the -C is a combined reagent blank and negative amplification control; it must be 
handled like a reagent blank. 
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• Internal Laboratory Control (Custom Control): When used, the internal laboratory control should genotype 
correctly and be free of contamination. Confirmation of peak height imbalances is not required. 

 
Samples 

Analysts will evaluate all samples based on the guidelines that follow. Workflow is at analyst discretion, although 

it is recommended to review samples that have met all analysis thresholds first, followed by samples with 

triggered PQV flags. The Analysis Summary tab in ID-X can be used to navigate easily to these two groups of 

samples. 

True Alleles 
True alleles are sharp, distinct peaks that are equal to or greater than the analytical threshold and typically have 
an estimated size between 60 and 500 bp. Peaks that are saturated (off-scale) or broad, but genotyping is not 
adversely affected, may be accepted by the analyst, in conjunction with the technical reviewer. 
 
Determination of a genotype is aided by the use of thresholds established during validation. 
 

Analytical Threshold: 120 rfu 
The analytical threshold (detection threshold) is the level at which a peak can reliably be detected above 
background fluorescence. 
 
Stochastic Threshold 
The stochastic threshold is the minimum peak height above which there is a high probability that both 
alleles of a heterozygous locus will be detected. Separate cycle-dependent stochastic thresholds are 
used to mitigate the effects of “ski sloping” (i.e. reduced allele heights at larger loci) with direct 
amplification. 
• 280 rfu: This threshold applies to any sample/control amplified at 26 cycles or less. 
• 500 rfu: This threshold applies to any sample/control amplified at 27 cycles or more. 

 
Heterozygous alleles are expected to appear as two peaks at least as high as the analytical threshold and have a 
peak height ratio of 60% or greater. Peak height ratios less than 60% will be confirmed by re-injection 
(Amelogenin is exempt from this requirement). Should the peak height imbalance persist, the analyst, in 
conjunction with the technical reviewer, may accept the sample. Otherwise, the sample shall be re-amplified. 
 
Homozygous alleles are expected to appear as single peaks at least as high as the stochastic threshold. 
 
An allele above analytical threshold may be unlabeled as the result of the global filter cut-off value (for example, 
an extreme peak imbalance due to a primer binding site mutation). Such an allele will be manually labeled by 
the analyst by right-clicking and selecting Add Allele Label. 
 
For Y STR loci, alleles are expected to appear as single peaks at least as high as the analytical threshold. 
 
Variant Alleles 
If an off ladder (microvariant) allele, tri-allele, or duplication at a Y STR locus is observed, the NIST STRBase 
website https://strbase.nist.gov/ will be checked to see if the variant has been previously reported using a CE 
platform and Fusion 6C. Novel variants will be reported to STRBase after proper confirmation and technical 
review. 
 

https://strbase.nist.gov/
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Off ladder alleles may be accepted without additional analysis if they have been previously reported at STRBase 
and the sizing quality of the sample is passing. The sample will be re-injected for confirmation if sizing quality is 
not acceptable. If an off ladder allele has not been previously reported, the sample will be re-injected, at a 
minimum, for confirmation. 
Occasionally a one base pair difference between two alleles cannot be resolved using typical methods like re-
injection or re-amplification. In such cases, the Polynomial Degree and Peak Window Size in ID-X may be 
adjusted. This will be documented in the case file and the modified analysis method will be included in the 
electronic data. 
The following table will be used as a guide for allele designations outside of the ladder. For off ladder alleles 
above or below the limits in the table and given an OL designation in ID-X, the applicable < or > will be used as 
the allele designation. For manual CODIS tables, the upper and lower values in the table must be used. 
 

LOCUS Lower Upper 

D3S1358 <12 >19 

D1S1656 <9 >20.3 

D2S441 <9 >16 

D10S1248 <8 >18 

D13S317 <8 >15 

Penta E <5 >24 

D16S539 <5 >15 

D18S51 <9 >26 

D2S1338 <15 >28 

CSF1PO <6 >15 

Penta D <2.2 >17 

TH01 <5 >10 

vWA <11 >21 

D21S11 <24.2 >38 

D7S820 <6 >14 

D5S818 <7 >16 

TPOX <6 >13 

D8S1179 <8 >18 

D12S391 <14 >27 

D19S433 <9 >17.2 

SE33 <4.2 >37 

D22S1045 <8 >19 

DYS391 <8 >13 

FGA <18 >30 

DYS576 <11 >23 

DYS570 <10 >25 

 
Tri-alleles and Y STR duplications that have been previously reported on STRBase will be re-injected for 
confirmation. If not reported, the sample will be re-injected, at a minimum, for confirmation. 
Abnormal sex chromosome variants (e.g. XXY) do not need to be re-tested. 
 
PCR and Genetic Analyzer Artifacts 
If an artifact can be confidently characterized as one of the following anomalies, the sample does not need to be 
re-tested. If there is any uncertainty about an anomalous peak or it may interfere with possible alleles, the 
sample should be re-run to ensure quality and accuracy of the allele calls. 
 
An artifact is acceptable if it meets the criteria defined below, is appropriately re-labeled by the analyst in ID-X, 
and the technical reviewer agrees that the artifact has been accurately characterized and documented, and is 
not due to contamination or another problem. The use of a global filter analysis method may result in artifacts 
remaining unlabeled by the software; these artifacts do not require labeling by the analyst. 
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• Spikes 
Spikes have a general appearance of being needle-like and are randomly seen in samples. Spikes typically 
disappear with re-injection. Commonly, spikes are observed in most or all of the dye colors and generally at 
the same base pair location. Occasionally, single color spikes may also be observed. The heights of spikes 
usually vary between dye colors. 
 
ID-X may automatically flag spikes within the analysis range. Spikes may also be flagged as something other 
than a spike and other artifacts, such as pull-up, may be labeled as spikes. Evaluate the artifact and PQV 
flags, and appropriately re-label the artifact.  

 

• Pull-up 
Pull-up artifacts are peaks that show up at the same base pair size or close (i.e. about a base equivalent on 
either side of the allele), but in another color. Pull-up usually occurs under peaks with excessive signal and 
may also occur between strong peaks. 

 

• Stutter 
Stutter is an artifact that occurs during PCR due to strand slippage and is a well-characterized amplification 
phenomenon. Stutter peaks are generally one repeat unit less than or greater than the allele, although n-2 
and n-8 stutter peaks may also be observed. Established stutter percentages aid in discriminating between 
stutter and other potential alleles (e.g. weak heterozygous or tri-allele peaks, contamination). Filters in 
stutter positions are set in ID-X using the percent values below. These filters may accommodate other 
known artifacts in addition to stutter. 

 
Locus n-5 n-4 n-3 n-2 n-1 n+3 n+4 n+5 

Amelogenin — — — — 10.0 — — — 

D3S1358 — 13.5 — — — — 1.7 — 

D1S1656 — 20.0 — 3.6 — — 2.3 — 

D2S441 — 9.0 — — — — 1.8 — 

D10S1248 — 13.0 — — — — 1.3 — 

D13S317 — 10.3 — — — — 2.2 — 

Penta E 7.2 — — — — — — 1.9 

D16S539 — 12.0 — — — — 3.0 — 

D18S51 — 14.6 — — — — 2.8 — 

D2S1338 — 13.6 — — — — 2.2 — 

CSF1PO — 11.1 — — — — 3.7 — 

Penta D 4.5 — — — — — — 3.7 

TH01 — 4.8 — — — — 1.5 — 

vWA — 14.4 — — — — 2.7 — 

D21S11 — 12.7 — — — — 2.8 — 

D7S820 — 9.7 — — — — 1.8 — 

D5S818 — 11.0 — — — — 2.3 — 

TPOX — 5.4 — — — — 1.1 — 

D8S1179 — 11.8 — — — — 3.4 — 

D12S391 — 17.4 — — — — 2.7 — 

D19S433 — 12.1 — 1.4 — — 2.6 — 

SE33 — 16.1 — 6.6 — — 3.3 — 

D22S1045 — — 20.0 — — 9.0 — — 

DYS391 — 9.4 — — — — 2.0 — 

FGA — 12.4 — 1.2 — — 2.8 — 

DYS576 — 12.5 — — — — 3.4 — 

DYS570 — 13.0 — — — — 2.4 — 



Washington State Patrol Crime Laboratory Division 

CODIS Lab STR Procedures Manual 

 

 
CODIS Lab STR Procedures Page 41 of 69 Revision January 1, 2024 

Approved by CLD Quality Manager All Printed Copies are Uncontrolled Revision 35 

 

An analysis method using a global filter may leave elevated stutter peaks unlabeled. When stutter peaks 
exceed the threshold by a minimal amount, it is acceptable for the analyst to pass or, if labeled by the 
software, re-label the peak. Larger deviations should be evaluated closely and may require re-amplification 
or extraction to determine if they are actual stutter peaks.  

 

• DNA-Dependent Artifacts 
The following DNA-dependent artifacts have been identified by the manufacturer of Fusion 6C and may be 
appropriate for the analyst to re-label after careful evaluation. 

 
Locus Artifact Size 

Amelogenin n-1 

D1S1656 n-1, n-2 

D13S317 n-2 

D18S51 n-2 

vWA n-2, elevated baseline 

D7S820 n-2 

D5S818 n-2 

D19S433 n-2 

SE33 n-2 

DYS391 n-1 

FGA n-1, n-2 

 

• Shoulders 
Shoulders flank the sides (one or both) of an allele. When shoulders are given a designation in ID-X and are 
10% or less of the parent allele, they may be re-labeled. For shoulders greater than 10% (either labeled or 
unlabeled according to the analysis method), the sample should be re-run at a shorter injection time, diluted 
with TE, or re-amplified. 

 

• Dye Blobs 
Raised baseline areas may represent dye blobs, which often occur around the same base pair location in 
multiple samples of a run. 
 

• Cross-Talk 
Fluorescence from a saturated sample in one capillary may be detected in a neighboring capillary. This cross-
talk typically appears as low-level peaks that are shifted outside of bins consistent with the saturated 
sample. Cross-talk may be acceptable if the source is identified and it does not interfere with profile 
interpretation. 

 
Contamination 
In instances of a suspected contamination event where the questioned PCR product is above the analytical 
threshold, troubleshooting will be conducted to determine where in the laboratory process it may have 
occurred. Note that an analysis method using a global filter may leave contaminating alleles above analytical 
threshold unlabeled. The contamination flow charts in the DNA Quality Assurance Manual should be consulted 
to assist with troubleshooting. Re-testing of samples or controls with suspected contamination below the 
analytical threshold is not required. 
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EVALUATING FUSION 6C PROFILES WITH GENEMAPPER® ID-X V1.6.2 AS AN 

EXPERT SYSTEM 
 
This procedure applies to the evaluation of DNA profiles using GeneMapper ID-X v1.6.2 as an Expert System, 
where the Expert System takes the place of human review. The Expert System may only be used on half volume, 
26-cycle Fusion 6C data generated on an AB 3500xL where the sample to well association is unbroken from 
barcode scan through ID-X analysis (i.e. first pass data). 
 
EVALUATING LADDERS AND CONTROLS 
 
1. Any passing allelic ladders do not have to be evaluated. 

 
2. Check or Low Quality allelic ladders must be evaluated by an analyst to verify the failure wasn’t due to a 

factor that affected the corresponding injection. 
 

3. In the case of more than one of the same kind of control (e.g. duplicate positive amplification controls), only 
one replicate must pass. If there is not a positive control under the “All Thresholds Met” column, view the 
positive control(s) under the “One or more thresholds not met” column and evaluate why they did not pass. 
Follow the guidelines already described in this manual for evaluation of positive controls. 
 

4. Select the negative control(s) and verify no contamination exists. Follow the guidelines already described in 
this manual for evaluation of negative controls. 

 
EVALUATING SAMPLES 
 
1. Samples in the “All Thresholds Met” column do not require analyst review. To export CODIS tables for these 

samples, select the number of the samples under the “All Thresholds Met” column under the “Analysis 
Summary” tab.  Select the correct Specimen Category. 
 

2. Select the number of samples under the “One or more thresholds not met” column. Assess each sample 
using the guidelines already described in this manual for evaluation of sample profile data.  Select the 
correct Specimen Category for each passing sample. 
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REPORTING PROFILES & CODIS DATABASE 
 
Profiles deemed appropriate to enter into the CODIS database must be peer reviewed or passed by the Expert 
System prior to entry. In cases where a full profile could not be generated, the partial profile may still be eligible 
for SDIS. Refer to the WSP CLD CODIS SOP Manual for further guidelines on entering convicted offender sample 
profiles in SDIS and NDIS. 
 
Profiles eligible for CODIS are reported in either electronic or manual tables; electronic tables should be used 
whenever possible. Manual tables may also be used for reporting profiles for hit confirmations. 
 
ELECTRONIC CODIS TABLES 
 
1. In ID-X, select the appropriate Specimen Category for each sample being exported. 
2. Select the desired run folder in the Navigation Pane, then select File > Export Table for CODIS. 
3. Ensure that the correct source and destination laboratories are selected and that the file type is CMF 3.2 

(.xml). 
4. Enter the file name, which should be the same as the run folder name, and click Export. 
 
MANUAL TABLES 
 
1. Make an allele table using Microsoft Excel, being sure to include all loci and reported alleles. This 

information can be exported from ID-X rather than transcribing. 
2. For partial profiles, single alleles above the analytical threshold and below the stochastic threshold (or any 

inconclusive genotype above the analytical threshold) will be in parentheses. These alleles will not be 
entered into CODIS, but may be used for exclusion or evaluating matches. 

 
COMPOSITE PROFILES 
 
In instances where a sample has been consumed and a full profile was not developed, but a more complete or 
full profile may be constructed by considering results from multiple tests of the sample, a composite profile may 
be generated. For a locus to be considered for use in the composite profile, it must meet the reporting 
requirements described in this manual. 
 
A manual table will be generated for reporting composite profiles. All run folders used for constructing the 
profile will be indicated on the Run Folder Review sheet. 
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CODIS CASE FILE CONTENT 
 
A CODIS Case File consists of all documentation related to CODIS Casework including hard copy and electronic 
data and/or worksheets. A CODIS Case File will contain, at minimum, the following items filled out with 
sufficient information as to appropriately record all of the pertinent data. 
 
1. Extraction Worksheet (if applicable) 

 
2. Microcon Worksheet (if applicable) 
 
3. 7500 Load Sheet (if applicable) 
 
4. Amplification Worksheet (for any manual amplification set-ups) 
 
5. 96 Well Worksheet (for any 96-well plate sets) 
 
6. Run Folder Review Sheet 
 
7. CE Loading & Reagent Worksheet (if applicable) 
 
8. Manual CODIS Table (when appropriate) 
 
9. CODIS Table (when appropriate) 
 
10. PDF of the puncher work list (when appropriate) 
 
11. Quantifiler™ Projects 
 
12. Raw Data folder(s) containing only those samples and controls related to a particular set 
 
13. GeneMapper® ID-X project (exported with analysis settings) 
 
14. Peer Review Checklist (to be added by the technical reviewer) 
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CODIS CASE FILE TECHNICAL REVIEW WITH GENEMAPPER® ID-X V1.6.2 AS AN 

ANALYSIS TOOL 
 
There are two fundamental steps to the review of CODIS case files which are to be performed by a qualified 
CODIS scientist: 
 

1. Review of the electronic data. 
2. Review of the associated paperwork from extraction through analysis to verify documentation is 

accurate. 
 
It is the responsibility of the reviewer to ensure the analyzed data is as accurate and complete as possible. At 
minimum the following will be done: 
 

1. Verify that all electronic documents and files are present. 
2. Check the GeneMapper® ID-X results. 

a. The correct analysis method will be verified. 
b. The ladders and quality control samples will be evaluated by the reviewer to ensure they meet 

the requirements as described in the Guidelines for Evaluating DNA Typing Profiles using GMID-
X section of this manual. 

c. The reviewer must look at all samples (to include the ILS) reported from a run folder. 
i. For samples where a flag was overridden or an edit was made, the reviewer must 

evaluate the changes. 
ii. When an edit has been made, the reviewer must ensure the original analyst 

documented the change appropriately in the GMID-X software. 
iii. If the reviewer agrees with the edited profile and/or the analyst’s assessment to 

override flags, the reviewer indicates this by overriding the Composite Genotype Quality 
(CGQ) of the sample. 

iv. For passing samples, the reviewer will evaluate the profiles for allele designations and 
that the sample is free from extraneous peaks. 

d. All samples shall meet the requirements outlined in the Guidelines for Evaluating DNA Typing 
Profiles using GMID-X section of this manual. In instances where they do not, but there is cause 
to report the sample, the CODIS supervisor, technical lead, or DNA Technical Leader may sign off 
on those samples if it is viewed as appropriate (i.e. smaller deviations may be signed off by the 
CODIS supervisor or technical lead as the DNA Technical Leader’s designees). This must be 
reflected in the case file. 

e. The CODIS tables will be evaluated to ensure the samples are reported from the correct run 
folder, the table is the correct export version, each sample has the appropriate Specimen 
Category, and that the analyst’s CODIS username is correct. 

3. Review the paper worksheets. 
a. Check that all information is filled out on the worksheets and that the appropriate worksheets 

are present. 
b. Check that the case numbers of the convicted offender samples are accurate across all 

worksheets. 
c. Verify that a set number, date, and initials are on each page. 
d. Ensure that all strikeouts and additions are initialed. 

 
For a more detailed list of what is required for the technical review of a CODIS Case File, see the CODIS 
Laboratory Peer Review Checklist. 
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CODIS CASE FILE TECHNICAL REVIEW WITH GENEMAPPER® ID-X V1.6.2 AS AN 

EXPERT SYSTEM 
 

1. Verify that the correct analysis method is used. 
  

2. Ladders do not have to be evaluated by a technical reviewer.  
 

3. The ILS of controls and samples under the “All Thresholds Met” column do not have to be reviewed by 
the technical reviewer. 
 

4. Controls: 
a. Check the negative controls under the “All Thresholds Met” column for contamination. 
b. Do not look at the other controls under the “All Thresholds Met” column. 
c. If any controls are under the “One or more thresholds not met” column, click on the number 

under the total number of controls in that column. 
d. Look at any control reported from the project to verify analyst overrides are appropriate. 
e. For any control with allele edits, use the “View Allele Edits” plot setting to verify artifacts/alleles 

are documented appropriately. 
f. If in agreement with the control overrides/edits, override the CGQ of the control. 

 
5. Samples: 

a. Do not view the genotypes of samples under the “All Thresholds Met” column. 
b. Click on the number under the “One or more thresholds not met” column. 
c. Look at any sample reported from the project to verify analyst overrides are appropriate. 
d. For any sample with allele edits, use the “View Allele Edits” plot setting to verify artifacts/alleles 

are documented appropriately. 
e. If in agreement with the sample overrides/edits, override the CGQ of the sample. 
f. Continue for all reported samples from the run folder. 

 
6. Review the electronic CODIS tables to ensure the appropriate samples are reported from the correct run 

folder with the correct Specimen Category, export version, and analyst CODIS username.  
 

For a more detailed list of what is required for the technical review of a CODIS Case File, see the CODIS 
Laboratory Peer Review Checklist.   
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REAGENT PREPARATION 
 
Use reagent grade chemicals unless otherwise noted. Pre-made, reagent grade chemicals can be substituted for 
many of the recipes below. Prepare all solutions using deionized water (dH2O). Wear gloves and follow safety 
recommendations provided by manufacturer for handling chemicals. Comply with any and all laws, regulations, 
or orders with respect to the disposal of any hazardous or toxic chemical, material, substance or waste. 
Reagents that are used solely for the preparation of other reagents do not need to be sterilized before making 
up the new reagent if that reagent will be sterilized. Store all reagents at room temperature unless otherwise 
noted. Reagents will be labeled with the reagent name, lot number, expiration date (if any), storage 
requirements (if not at room temperature), preparer’s initials, and date of preparation. Reagents are prepared 
as follows: 
 
RECONSTITUTED CARRIER RNA (1 µg/µL) 
 
Add 310 µL TE buffer to lyophilized carrier RNA. Vortex to ensure RNA is thoroughly dissolved and aliquot into 
small portions. Store frozen. 
 
QUANTIFILER™ QUANTIFICATION STANDARDS 
 
DNA quantitation standards are critical for accurate analysis of run data. Any mistakes or inaccuracies in making 
the dilutions directly affect the quality of the results. Great care shall be taken when measuring and mixing 
dilutions. 
 

1. Prepare the DNA Quantitation Standards using G147A (Promega catalog #G1471) genomic DNA (SRM 
2372 traceable) 

 
2. Label eight disposable tubes to be used for the dilution series. 

 
3. Prepare the TE with glycogen by adding 1 µL glycogen to 1 ml of TE. Vortex. 

 
4. Dispense the required amount of TE/glycogen to each tube. (See note* on next page to adjust for lot to 

lot variation in stock DNA standard.) 
 

5. Prepare the standards using the following table. 
 

a. For standard 1: 
i. Briefly vortex the G147A Human DNA Standard and pulse spin. 

ii. Using a new pipette tip, add the calculated amount of G147A Human DNA Standard to 
the tube for Standard 1. 

iii. Vortex and pulse spin the dilution 
b. For standards 2 through 8: 

i. Using a new pipette tip, add the calculated amount of the previously prepared standard 
to the tube for the next standard. 

ii. Vortex and pulse spin the standard. 
iii. Repeat steps 5.b.i and 5.b.ii until the dilution series is completed. 

 
6. The prepared Human DNA Standards may be stored for up to 4 weeks at 2 to 8°C. 
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Standard 
Concentration 

(ng/µL) 
Example Amounts Minimum Amounts† 

Dilution 
Factor 

*Std. 1 50.000 
50 µL [200 ng/µL stock*] + 150 µL 
TE/glycogen buffer 

10 µL [200 ng/µL stock]+ 30 µL TE/glycogen 
buffer 

4X 

Std. 2 16.700 50 µL [Std. 1] + 100 µL TE/glycogen buffer 10 µL [Std. 1] + 20 µL TE/glycogen buffer 3X 

Std. 3 5.560 50 µL [Std. 2] + 100 µL TE/glycogen buffer 10 µL [Std. 2] + 20 µL TE/glycogen buffer 3X 

Std. 4 1.850 50 µL [Std. 3] + 100 µL TE/glycogen buffer 10 µL [Std. 3] + 20 µL TE/glycogen buffer 3X 

Std. 5 0.620 50 µL [Std. 4] + 100 µL TE/glycogen buffer 10 µL [Std. 4] + 20 µL TE/glycogen buffer 3X 

Std. 6 0.210 50 µL [Std. 5] + 100 µL TE/glycogen buffer 10 µL [Std. 5] + 20 µL TE/glycogen buffer 3X 

Std. 7 0.068 50 µL [Std. 6] + 100 µL TE/glycogen buffer 10 µL [Std. 6] + 20 µL TE/glycogen buffer 3X 

Std. 8 0.023 50 µL [Std. 7] + 100 µL TE/glycogen buffer 10 µL [Std. 7] + 20 µL TE/glycogen buffer 3X 

†To ensure the accuracy of pipetting, the minimum input volume of DNA for dilutions is 10 µL. 
 

*NOTE: How to adjust for lot to lot variation in the Human DNA Standard: 
Use the SRM 2372 kit from NIST to determine the DNA concentration of each new lot of G147A DNA 
standard. For step 1 of preparing the Quantitation Standard sets, dilute the stock according to the actual 
concentration obtained for the new lot of DNA. The rest of the dilution steps remain the same. 

 
DISPENSING HI-DI FORMAMIDE 
 
Hi-Di Formamide is harmful if swallowed, inhaled, or absorbed through the skin. See MSDS for full disclaimer. 
When aliquoting Hi-Di Formamide, work in a fume hood with gloves and lab coat. 
Remove the Hi-Di bottle from the freezer and allow it to come to room temperature until contents have thawed. 
Aliquot 1 mL Hi-Di into 1.5 mL autoclaved tubes. Label each tube with the lot, date of dispensing, and initials. 
Freeze immediately. 
 
REAGENT EXPIRATION DATES 
 
The following table lists expiration dates for reagents used in the CODIS Laboratory. Reagents that are tested 
before each use do not require an expiration date. Should a stock solution purchased from a distributor be used 
rather than being made in the lab, the expiration date on the bottle overrides any expiration date listed here. 
 
Commercially prepared critical reagents that do not have an expiration date assigned by the manufacturer will 
be assigned one by the laboratory based on performance testing and review of scientific literature or up to three 
years from receipt. 
 
Non-critical commercially prepared reagents that do not have an expiration date assigned by the manufacturer 
do not need one assigned by the laboratory provided they are stored and maintained appropriately. The 
integrity of these reagents, as with any reagent, will be monitored at the time of use. 
 

Reagent Expiration Dates 

Buffer MTL 3 years 

Carrier RNA Same as EZ1 DNA Investigator kit 

QF Standards 4 weeks if in glycogen 
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TEMPGENIUS™ WIRELESS DATA ACQUISITION & MONITORING SYSTEM 
 
The TempGenius system is used to wirelessly record the temperature for refrigerators, freezers, and ovens in 
the lab. Rather than recording the temperature of a unit at one time of day, TempGenius constantly monitors 
and records the temperature. If a unit falls outside of the desired temperature range, TempGenius will alert the 
user and record the event. This allows for more effective monitoring of refrigerators, freezers, and ovens. 
 
GENERAL INSTALLATION AND OPERATION 
 
Refer to the TempGenius “Installation Guide And Operating Manual”. 
 
ALERTS AND RESOLUTIONS 
 
TempGenius automatically monitors temperatures and sends alerts to the assigned user(s) and TempGenius 
Dashboard. In addition to viewing temperatures on the Dashboard, real-time temperatures may be viewed 
remotely by accessing the IP address of the TempGenius Data Server. Refer to the TempGenius Installation 
Guide and Operating Manual for instructions on alerts and alert resolutions. 
 
TROUBLESHOOTING ALERTS 
 
Use the following table as a guide for troubleshooting alerts. 
 

Alert Type Critical Unit? Action Address Off-Hours? 

Level 1 No If more than two days in a row, verify reading against a NIST 
thermometer. If NIST is within allowable range, contact the 
TempGenius rep, otherwise troubleshoot until a solution is 
reached. 

No 

Level 1 Yes If more than two days in a row, verify temperature reading 
against a NIST thermometer. If NIST is within the allowable 
range, contact the TempGenius rep, otherwise move contents of 
unit to another location until a solution can be reached. 

No 

Level 2 No Verify reading against a NIST thermometer. If NIST is within 
allowable range, contact the TempGenius rep, otherwise 
troubleshoot until a solution is reached. 

No 

Level 2 Yes Verify the temperature reading against a NIST thermometer. If 
NIST is within the allowable range, contact the TempGenius rep, 
otherwise move contents of unit to another location until a 
solution can be reached. 

Yes, if a volunteer is 
unavailable, notify 
CODIS Manager 

Level 3 No Verify the temperature reading against a NIST thermometer. If 
NIST is within the allowable range, contact the TempGenius rep, 
otherwise troubleshoot as needed. 

No 

Level 3 Yes Verify the temperature reading against a NIST thermometer. If 
NIST is within the allowable range, contact the TempGenius rep, 
otherwise move contents of unit to another location until a 
solution can be reached. 

Yes, if a volunteer is 
unavailable, notify 
CODIS Manager 
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TEMPGENIUS™ WIRELESS DATA ACQUISITION & MONITORING SYSTEM 

MAINTENANCE 
 
MONTHLY 
 
Daily historical temperature readings and TempGenius Corrective Actions for each sensor will be compiled 
monthly and saved electronically to a dedicated folder. 
 
Daily Historical Readings 

1. From the TempGenius Dashboard, click on “View Reports”. 
2. Select the 90 Day Historical Data tab.  
3. Select a sensor, start date, and end date. 
4. Click “Get Historical Data”, then “Export Data to Excel”. 
5. Save the Excel file to the DR. 

 
Corrective Actions 

1. From the TempGenius Dashboard, click on “View Reports”. 
2. Select the Corrective Actions tab. 
3. Select a sensor, start date, and end date. 
4. Click “Get Data”, then “Export Data to Excel”. 
5. Save the Excel file to the DR. 

 
SEMIANNUALLY 
 
A NIST probe reading for each monitored unit will be recorded semiannually, to ensure the accuracy of the 
temperature readings recorded by TempGenius. If the difference between the TempGenius reading and the NIST 
reading is outside the allowable range, another reading will be taken at a different time. In the event that the 
TempGenius reading is once more outside the range, contact the manufacturer. 
 
ANNUALLY 
 
Calibration of sensors – see the TempGenius “Installation Guide and Operating Manual” 
 
The manufacturer defines the annual calibration as the adjustment (or replacement) of a sensor due to 
temperature variability against a NIST probe. The average offset for a sensor will be determined based on the 
total readings for the year. The laboratory may choose to make an adjustment if the offset between the sensor 
and NIST probe is +/-1°C. If the average offset of a sensor is more/less than +/- 4°C, an adjustment is mandatory 
and the manufacturer will be contacted. 
 
If any adjustment is made to the sensor, a reading with A NIST probe will be taken the following day to verify the 
adjustment. All adjustments will be documented on the TempGenius maintenance sheet. 
 
AS NEEDED 
 
Replace the batteries in the sensors by unscrewing the transmitter cover. 
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UV IRRADIATOR OPERATING INSTRUCTIONS 
 
OPERATION 
 

1. Turn the power on. The digital display should read 0000 or 0; if it does not, press reset. 
 

2. Place the consumables in an orientation to allow maximum exposure. 
 

3. Select the Energy button. The number on the display represents microjoules/cm2 x 100. 

• For autoclaved consumables, set the microjoule level to 500,000 μJ/cm2. 

• For non-autoclavable consumables, set the microjoule level to 999,900 μJ/cm2 
 

4. If an error is made in entering, press the reset button to clear the display. 
 

5. Press start to begin irradiation. 
 
MAINTENANCE 
 

1. Clean the floor of the UV Irradiator with a soft cloth and nonabrasive cleaner once a week. 
 

2. Change bulbs as needed. 
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BSD600 DUET PUNCHER MAINTENANCE 
 
BEFORE EACH USE 
 

1. Clean the outside of the puncher, the chute, and the punch mechanism. See user manual for detailed 
instructions. 

 
2. Empty the waste punch container if needed. 

 
3. Ensure the sponges in the humidifier bottles are moist. 

 

 

BSD600 ASCENT PUNCHER MAINTENANCE 
 
BEFORE EACH USE 
 

1. Clean the outside of the puncher, the chute, and the punch mechanism. See user manual for detailed 
instructions. Do NOT clean the outer chute with alcohol. No liquids should be used on the outer chute or 
damage to electronic sensors may occur. 
 

2. Empty the waste punch container if needed. 
 

3. Using a small amount of DI water, wet the sponge and ensure all water is absorbed.  

• The cleaning brush can be used to push the sponge down into any non-absorbed liquid in the 
bottom or bottle can be rotated to distribute water to dry portions of the sponge.  

• Do not soak or oversaturate the sponge.  

• Do not turn on the punch instrument until water is absorbed by the sponge. 
 
 
ANNUAL 
 
On a yearly basis, the BSD600 Duet and Ascent punchers will be serviced by a qualified technician. 
 
PERFORMANCE CHECKS 
 
A performance check will be done following repair or routine maintenance by a qualified technician. The check 
must be completed prior to use for convicted offender sample analysis and will address the reliability of the 
instrument. 
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EZ1® ADVANCED XL MAINTENANCE 
 
AFTER EACH RUN 
 

1. Clean the EZ1 worktable and cartridge rack with ethanol followed by dH2O. 
2. Close the workstation door and follow the prompts to clean the piercing unit. 
3. Open the workstation door and wipe the piercing unit using a tissue moistened with ethanol followed by 

a tissue moistened with dH2O. 
4. Clean the metal plate underneath the EZ1 worktable with ethanol followed by dH2O. 
5. Wipe the outer surface of the instrument and the blue door using a tissue moistened with ethanol 

followed by a tissue moistened with dH2O. 
6. Close the workstation door. 
7. Run the UV protocol by selecting 1: UV from the main menu. Enter the length of the UV run between 20 

and 60 minutes (default 20 minutes). 
 
MONTHLY 
 
Grease the O-rings: 

1. Open the workstation door. 
2. Remove the worktable and cartridge rack and push back the tray holder. 
3. Add a small amount of silicone grease to each pipettor head O-ring using any method that minimizes the 

amount of grease added. One method that can be used is to add a small amount of silicone grease to 
the inside top edge of an unused filter-tip. Place this tip onto the pipettor head, and rotate the tip over 
the O-rings. 

4. Wipe off any excess grease. 
 

 
ANNUALLY 
 
On a yearly basis, the EZ1 will be serviced by a QIAGEN technician. 
 
PERFORMANCE CHECK 
 
A performance check shall be conducted prior to use on casework for each new EZ1. This performance 
verification shall address reliability and test for contamination and shall be documented. 
 
Following yearly maintenance or repair, the instrument will be performance checked by extracting a known 
sample and a reagent blank followed by quantification of the samples. The extracted samples shall yield 
sufficient DNA to target a robust amplification and the blank shall be free of DNA (i.e., Undet.); however, 
amplification is not required. If amplified, the known sample shall genotype correctly and the blank shall be free 
of DNA. 
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7500 REAL TIME PCR SYSTEM MAINTENANCE 
 
MONTHLY 
 

1. Check the lamp status 
 

2. Although background calibration is valid for six months in the 7500 Software, the block shall be checked 
monthly for contamination by performing a background calibration in the Instrument Maintenance 
Manager. 

 
3. Perform a Function Test 

 
SEMI ANNUALLY 
 

1. Check the Lamp Status 
 

2. Perform all calibrations as prompted by the 7500 Software Instrument Maintenance Manager. The 
RNase P run does not need to be performed. 

 
3. Perform a Function Test 

 
ANNUALLY 
 
Preventive maintenance, including all semi-annual maintenance tasks, will be performed by a qualified 
technician 
 
PERFORMANCE CHECKS 
 
A performance check will be done on an instrument if it has been moved or following repair or routine 
maintenance done by a qualified technician. The check must be completed prior to use for convicted offender 
sample analysis and consists of: 
 

1. ROI, background, optical, and Pure Dye calibrations (may be performed by the technician) 
 

2. A quantification plate containing previously quantified samples. 
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9700 THERMAL CYCLER MAINTENANCE 
 
BIANNUALLY 
 
This maintenance is considered the annual performance check as required by the QAS. 
 

1. Clean the sample wells and heated cover 
 

2. Run the Calibration Verification test 
 

3. Run the Temperature Non-Uniformity test 
 
AS NEEDED 
 
Send to a qualified technician for external calibration or repair. 
 
PERFORMANCE CHECK 
 
A performance check will be done following repair or maintenance by a qualified technician. The check must be 
completed prior to use for convicted offender sample analysis and will consist of the Calibration Verification and 
Temperature Non-Uniformity tests plus positive and negative amp controls. 
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PROFLEX PCR SYSTEM MAINTENANCE 
 
BIANNUALLY 
 
This maintenance is considered the annual performance check as required by the QAS. 
 

1. Clean the sample wells and heated cover. 
 

2. Run the following diagnostic tests: 
a. Temperature Verification Test 
b. Temperature Non-Uniformity Test 
c. Heated Cover Test 
d. Self-Verification Test  

 
AS NEEDED 
 
Send to a qualified technician for external calibration or repair. The Cycle Performance Test may be run to 
troubleshoot instrument performance. 
 
PERFORMANCE CHECK 
 
A performance check will be done following repair or maintenance by a qualified technician. The check must be 
completed prior to use for convicted offender sample analysis and will consist of the 4 diagnostic tests normally 
performed during biannual maintenance plus positive and negative amplification controls. 
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3500XL GENETIC ANALYZER MAINTENANCE 
 
SPATIAL CALIBRATION 
 
A spatial calibration must be performed every time a capillary array is removed or replaced, the detector door is 
opened, or the instrument is moved. 
 

1. In the Maintenance navigation pane, select ‘Spatial Calibration’. 
 

2. Select either ‘Fill’ or ‘No Fill’, then start the calibration. 
 

3. Evaluate the calibration results to ensure that there is: 
a. A sharp peak for each capillary (small shoulders are acceptable). 
b. A ‘+’ marker at the apex of each peak and no off-apex markers. 
c. An even peak profile (all peak about the same height). 

 
4. Accept the results if the criteria above are met. Refer to the 3500xL User Guide if the calibration fails. 

 
SPECTRAL CALIBRATION 
 
Perform a spectral calibration when a new dye set/polymer combination is used, if a new capillary array is 
installed, after any service on the optics, or if there is an increase in pull-up observed. 
 
At first use, thaw the 6C Matrix Mix and Matrix Mix Dilution Buffer completely. After first use, store the reagents 
at 2 – 10°C. 
 

1. Pre-heat the oven to 60°C, ideally 30 minutes before the first injection. 
 

2. Vortex the 6C Matrix Mix for 10 – 15 seconds. Add 10 µL of 6C Matrix Mix to one tube of Matrix Dilution 
Buffer. Vortex for 10 – 15 seconds. The diluted 6C Matrix Mix can be stored for up to 1 week at 2 – 10°C. 

 
3. Add 10 µL of the diluted 6C Matrix Mix prepared in step 2 to 500 µL of Hi-Di Formamide. Vortex for 10 – 

15 seconds. 
 

4. Add 15 µL of the 6C Matrix Mix with formamide prepared in step 3 to each well of a full 24 capillary 
injection of a 96-well plate. Cover with a plate septum and centrifuge briefly to remove bubbles. DO 
NOT heat denature. 

 
5. Place the assembled plate onto the instrument. Select ‘Spectral Calibration’ in the Maintenance 

navigation pane. Select ‘Matrix’ for the chemistry standard and ‘Promega J6’ for the Dye Set. 
a. The software will automatically run up to 3 injections to obtain a passing calibration. 
b. Not allowing capillary borrowing generally produces better results, but the software may be 

configured to allow up to 3 borrowing events. 
 

6. Start the calibration. 
 

7. Evaluate the results and choose ‘Accept’ or ‘Reject’. Refer to the 3500xL User Guide for detailed 
instructions on evaluating calibration data. 
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The 3500 Series Software employs wizards to assist the user in performing maintenance procedures. Access the 
appropriate wizard from the Maintenance Wizard screen and follow the prompts to complete any required 
tasks. The Maintenance calendar on the Dashboard may also be used to remind users when task are due. 
 
BEFORE EACH RUN 
 

• Check for any bubbles in the pump block and lines. If present, use the Remove Bubble Wizard. 

• Check consumables on the Dashboard. Replace polymer and buffers if needed. 
 
WEEKLY 
 

• Restart the instrument and computer. 

• Clean the anode buffer container valve pin. 
 
MONTHLY 
 

• Run the Wash Pump and Channels wizard and replace the polymer. 

• Flush the pump trap. 

• Replace the cathode buffer container septa. 

• Clean the autosampler and drip tray. 
 
ANNUALLY 
 

• Preventive maintenance will be performed by a qualified technician. 
 
AS NEEDED 
 

• Replace the capillary array using the Install Capillary Array wizard when poor precision or allele calling is 
noted, or when resolution or signal intensity decreases. Arrays may be used past the manufacturer’s 
expiration date. 

• Perform spectral or spatial calibrations (see sections above). 

• If the instrument will not be in use for more than 2 weeks, refer to the 3500xL User Guide for further 
information on proper care of the instrument. 

 
PERFORMANCE CHECKS 
 

• A performance check will be done on an instrument if it has been moved and following repair or routine 
maintenance done by a qualified technician. The check must be completed prior to use for convicted 
offender sample analysis and consists of successfully running a ladder, a negative amplification control, 
and a positive amplification control (or other known sample).  
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GENEMAPPER® ID-X V1.6.2 SERVER MAINTENANCE 
 
WEEKLY 
 

1. Restart the computer. 
 

2. Review the statistics for the database (see the GeneMapper ID-X Administrator’s Guide for the full 
procedure). 

 
QUARTERLY 
 
If ID-X is being used as an Expert System, run re-certification samples according to the NDIS Operational 
Procedures Manual. 
 
AS NEEDED 
 

1. Review password policies 
 

2. If using the audit system, review 
 

3. If using the electronic signature system, review 
 

4. Manage user accounts 
 

5. Manage security groups 
 

6. Manage profiles 
 

7. Back up security settings after making changes 
 

8. Back up and delete audit records. 
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TUTTNAUER TABLETOP AUTOCLAVE – INSTRUMENT MAINTENANCE 
 
PRIOR TO USE 
 
Fill the water reservoir by removing the cover and pouring deionized water into the reservoir through the 
opening on the top of the autoclave until it reaches the base of the safety valve holder (approximately 3 liters). 
 
WEEKLY 
 
Clean the door gasket with a mild detergent, water and a soft cloth or sponge. The gasket should be clean and 
smooth. 
 
MONTHLY 
 

1. Change the water in the water reservoir 
a. Ensure that the electrical cord is disconnected and there is no pressure in the autoclave. 
b. To drain the reservoir, turn the drain valve counter clockwise to the open position. Place a 

bucket underneath to catch the flow of water. Fully drain the reservoir. 
c. With a quart of tap water flush out the reservoir. 
d. Turn the drain valve clockwise to the closed position and fill the reservoir with deionized water 

to just below the safety valve. Plug the electrical cord in. 
 

2. Clean the water sensor 
a. Wipe the sides and tip of the water sensor (located in the rear of the chamber) with a mild 

soapy solution. 
b. It is very important the sides of the sensor are wiped clean. 

 
QUARTERLY 
 

1. Clean the air jet 
a. Remove the water reservoir cover. 
b. Clean the hole of the jet by manipulating the air trap wire back and forth ten (10) times. 
c. It is preferred that the cleaning is done while the unit is running a cycle and under pressure, but 

it can also be done while the unit is idle. 
 

2. Clean and descale the chamber, copper tubes, and reservoir using ChamberBrite™. Follow the 
procedure for cleaning the autoclave as outlined in the Tuttnauer Tabletop Autoclave maintenance 
manual. 

 
3. Clean the trays and tray holder 

a. Clean the tray holder and trays with detergent or non-abrasive stainless steel cleaner and water. 
b. Rinse immediately to avoid staining the metal. 
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AS NEEDED 
 
See procedures as outlined in the Tuttnauer Tabletop Autoclave Maintenance Manual. 
 

1. Clean and check the safety valve 
 

2. Replace the door gasket 
 

3. Clean the fan grid with compressed air from the inside outward 
 

4. Clean the strainer 
 

5. Inspect the locking device for wear 
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APPENDIX A: ADMINISTRATIVE PROCEDURES FOR PROCESSING OFFENDER 

SAMPLES 
 
BLOOD SAMPLES 
 

1. If no convicted offender card is included, one should be created from the information obtained from any 
paperwork accompanying the sample. All documentation should reference the blood sample. The card 
should be filed as usual and any original paperwork will be retained by the laboratory.  

 
2. See the Processing of Convicted Offender Samples section of this manual for more information about 

how blood samples are received and stored. 
 
 
PARAFFIN EMBEDDED TISSUE (PET) SAMPLES 
 

1. The sample should be transferred to a zipper lock bag, labeled with a barcode, and stored in numerical 
order in a sample storage freezer. 

 
2. If no convicted offender card is included, one should be created from the information obtained from any 

paperwork accompanying the sample. All documentation should reference the frozen sample. The card 
should be filed as usual and any original paperwork will be retained by the laboratory. 

 
 
BUCCAL SAMPLES 
 

1. Group sample envelopes by date received. 
 

2. Group sample envelopes by submitting agency. If there is not a return address, group by postmark and 
open to determine agency. If there is no postmark, open envelope to determine agency. 

 
3. Group sample envelopes by initials on the security seal. 

a. If the seal is absent or tampered with, set the sample aside for follow-up with the collecting 
agency. The sample may be accepted if recollection is not possible, and a note should be written 
on the submission card. 

b. If the initials are absent, open envelope to verify that collector information is filled out. If the 
collector identity cannot be determined, set the sample aside for follow-up with the agency. 

 
4. Open envelopes one at a time keeping the groups together. Verify: 

a. Offender information is filled out correctly, and a Washington State Identification (SID) Number 
is present and there is a qualifying offense listed on the submission card. 

b. Collector information is complete: 
i. Collector’s signature is present. 

• If no signature is present, initial and date the “Collector’s Signature” field after 
verifying that the collector has initialed the security seal on the envelope. 

• If neither signature nor initials are present, set the sample aside and then call to 
verify collector. 

ii. The agency name is present and distinctive. 
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• If the agency is not listed or the abbreviation is ambiguous and it can be 
determined from: the postmark, return address on the envelope or group of 
samples it was submitted with; fill in the appropriate information and initial and 
date the addition. 

iii. If the collector information cannot be determined, set the sample aside and call for 
clarification. 

c. The thumbprints are distinctive and the ridges can be clearly seen. 
d. The DNA sample is obvious on the FTA® paper, i.e. pink paper has turned white. 
e. For the multi-component kit, verify the convicted offender’s name, SID number (an eight- digit 

number) and date of birth, if printed on the outer part of the FTA® card, corresponds to the 
information on the submission card. 

f. If criteria in 4.a-4.e are met, skip to the Assigning Lab Numbers section below. 
g. If 4.a is insufficient, look up the missing data on the convicted offender’s criminal history, court 

records, or call the collecting agency for clarification. If an offense is determined to be non-
qualifying, and the offender does not have a previous qualifying conviction, the sample must be 
rejected. 

 
5. Agencies that submitted samples that were set aside because of a violation in step 3, 4.b.i, or 4.c 

through 4.e should be contacted to request a recollection; emphasize that the entire kit needs to be 
redone. If a recollection is not possible, the sample may be accepted at the discretion of a CODIS staff 
member. 

 
6. When a sample is rejected, fill out the rejection log with the pertinent information. The collecting 

agency will be notified of the following procedure: The rejected sample will be retained for one year 
should there be a reason to accept it within that time (e.g. a qualifying offense becomes available). After 
one year the sample will be destroyed if there are no updates to warrant its acceptance. 

 
 
ASSIGNING LAB NUMBERS 
 

1. Lab numbers depend upon lab location and the year of submission. 
a. An example of a lab number assigned to a convicted offender is 824-005234. 

i. The lab number begins with the lab code (8 = CODIS). 
ii. The next two digits refer to the year (24 = 2024). 

iii. The remaining six digits are the actual sample number. Each successive sample is 
assigned the next number in the sequence. 

 
2. For blood and PET samples, based on the numbering rules above, write the next lab number, in 

sequential order, on the zipper lock bag and associated submission paperwork. 
 

3. The remaining steps are for buccal samples. Begin with the presorted samples from the Receiving 
Samples section. 

a. For the all-in-one sample card: 
i. Number the card with the next available number in the sequence in the box labeled “for 

Crime Lab Use Only”. Numbering may be done by hand or with pre- printed labels. 
b. For the multi-component kit: 

i. Number a 3⅜” x 6” clasp envelope with the next available number in the sequence at 
the top center of the envelope (the envelope flap should be to the left). Numbering may 
be done by hand or with pre-printed labels. 
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ii. Place the FTA card in the envelope. 
iii. Number the corresponding submission card on the front, upper-right corner of the 

folded submission card so that it can be matched to its barcode label later. Alternatively, 
numbering the card is not necessary if the label is affixed immediately. 

 
4. Repeat with the remaining samples. Be sure to keep the numbers in order. It is acceptable to intermix 

both types of buccal collection kits. 
 
 
ENTERING DATA INTO THE CONVICTED OFFENDER ENTRY FORM 
 

1. For all samples, open the Convicted Offender Entry Form. 
 

2. Make sure Caps Lock is on. 
 

3. Select the proper entry type. When entering an all-in-one sample card, be sure to keep the FTA® paper 
covered. 

a. Washington State Identification numbers (SIDs) are usually eight digits. When “SID Number” is 
selected, the entry field will contain a “WA” prefix. 

b. If a SID number is unavailable, use the “Other Number” type and preface the number with one 
of the following abbreviations: 

i. Juvenile numbers are six digits or a letter and five digits and may be categorized as 
JUVIS, JRA or JV. 

• If JUVIS is specified, use JUV. 

• If JRA is specified, use JRA. 

• If nothing is specified, but juvenile can be determined by date of birth or facility, 
then use JV. 

ii. Social Security numbers should be abbreviated as SSN and entered without hyphens or 
spaces. Verify with the institution beforehand that this is the only ID available. 

iii. Department of Corrections numbers should be abbreviated as DOC. Verify with the 
institution beforehand that this is the only ID available. 

iv. Local Identification numbers should be abbreviated as Local ID. Verify with the 
institution beforehand that this is the only ID available. 

v. Out-of-state Identification numbers should be prefaced with the state’s two letter 
abbreviation. Verify with the institution beforehand that this is the only ID available. 

vi. FBI numbers shall be prefaced with FBI. Verify with the institution beforehand that this 
is the only ID available. 

vii. Washington State Driver’s License numbers usually begin with WDL and should be 
entered as-is. Verify with the institution beforehand that this is the only ID available. 

c. If no number is available indicate “No ID”. Make all attempts to obtain a number from the 
submitting agency before this step. 

 
4. Click Enter. 

 
5. If using entry type 3.a, a dialogue box will appear containing the name, date of birth, and DNA status 

found in W3 for the entered SID number. If an error message appears, check the SID to verify that it was 
entered correctly and if it still does not work, set the sample aside to be looked up later. 

a. Verify that name and date of birth match the submission card. Some offenders will have 
multiple names and/or dates of birth; the Convicted Offender Program will insert the first listed 
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name or date of birth in W3 into the Convicted Offender Entry Form. For the sake of 
consistency, if there is more than one name and/or date of birth listed in the dialogue box, the 
first one in the list will be assigned to that SID number. If the submission card has an alias name 
and/or date of birth, note this on the card and write in what will be used (date and initial). If 
either the name or date of birth on the submission card is not listed in the dialogue box, set the 
sample aside to be looked up later. 

b. Check DNA status. 
i. If it says “DNA NOT Taken”, Click OK. 

ii. If it says “DNA Taken” stamp the following with a “Duplicate” stamp: 

• For blood samples, stamp the top of the submission sheet and outside of the zip 
top bag containing the blood sample. 

• For the all-in-one sample card, stamp the collector information side of the card. 

• For the multi-component kit, stamp the front center of the clasp envelope and 
the upper left corner of the open submission card. 

iii. Click OK. 
c. “Last Name”, “First Name”, “Middle Initial” (if available in W3), “Date of Birth”, “Gender”, and 

“Individual Type” fields will populate automatically. Continue entry as follows: 
i. Tab to “Offense Description”. Enter offense from submission card. Common 

abbreviations are okay. 
ii. Tab to “Collector’s Institution”. Enter institution from submission card. 

iii. Tab to “Collector’s Name”. Select the representative that did the collection.  
iv. Tab to “Request Date”. Enter date received. 
v. Tab to “Case Number” and enter the previously assigned lab number. Click OK. 

vi. Verify the appropriate barcode quantity is selected to label the sample and 
submission paperwork. Typical selections are: 

• For blood and PET samples, select 2. 

• For the all-in-one offender card, select 1. 

• For the multi-component offender card, select 3. 
vii. Click OK to complete the case entry and print barcode label(s). 

d. If a suffix addition (e.g. Jr., Sr., III) is made to a previously existing sample in LIMS, the Case Info 
tab will be documented with this change. 

 
6. If using entry type 3.b or 3.c, a new entry form will appear (“Individual Type” will be automatically set). 

Enter first and last name, middle initial, gender, and date of birth. Continue as in steps 5.c.i – 5.c.x. 
 
 
AFFIXING LABELS 
 

1. Make sure the number on the label is the same as the number on the Submission Card; and for the 
multi-component kit, on the corresponding envelope. 

 
2. Place a label on the “CRIME LAB USE ONLY” space on the Submission Card. 

 
3. For the multi-component kit: 

a. Verify that any information written on the FTA® card matches the corresponding Submission 
Card. 

b. Place the next label on the outer cover of the corresponding FTA® card. Do not cover any 
convicted offender information that may be written on the flap; instead place the label on the 
back. 
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c. Place the last label over the number already present on the outside of the clasp envelope. 
d. Place the FTA® and Submission Cards into the envelope. 

 
4. File the sample in numerical order in the filing cabinet. 

  
 
ADMINISTRATIVE ERRORS 
 

Error Description Correction 
Duplication of 
a case number 

A particular case number is 
assigned to more than one 
sample 

LIMS will not allow duplicate entries of a case number. Upon 
discovery of such a duplicate, merely assign the next available case 
number to the submission card and sample envelope (initial if 
making a strikeout). 

Mis-entering a 
case number 

A case number is entered into 
the Convicted Offender form in 
the wrong format (e.g. 406-
123456 or 1061-23456). 

E-mail the LIMS Administrator with a request to delete the 
incorrect number. Wait for a response that the incorrect number 
was deleted from LIMS (otherwise a duplicate entry will be 
created). Ensure that the DNA Taken flag has been changed to no 
(unless the sample was already a duplicate). Re-enter the sample 
information with the correct number. Print and affix new labels. 

Missing FTA 
card 

An FTA card is not included with 
its corresponding submission 
card. 

Set the card and envelope aside until the correct pairing can be 
established. If a match cannot be made, a request will be made of 
the agency to obtain another sample. Set the card/sample aside 
until the mismatch is ameliorated. 

Switched FTA 
cards 

An FTA card is incorrectly paired 
with a submission card. 

Set the card and envelope aside until the correct pairing can be 
established. If a match cannot be made, a request may need to be 
made of the agency to obtain another sample. Set the card/sample 
aside until the mismatch is ameliorated. 

Skipped case 
number 

A case number is omitted in the 
sequence (e.g. 106- 123456 → 
106-123458), usually discovered 
by browsing stored submission 
cards. 

Ensure that the missing number has not previously been assigned 
to a card that may have been removed from storage. Assign a new 
card & sample with the skipped case number. This should only be 
done for samples received in the same year. 

Entering the 
wrong request 
date 

The incorrect request/receipt 
date was entered into the 
Convicted Offender entry 
program. 

Wait for the date to be updated in LIMS (usually a day after entry), 
then manually make the correction. Print and affix new labels. 

Mislabeling A submission card and/or 
sample envelope is labeled 
incorrectly. 

If possible, remove the incorrect label(s) and determine to which 
card/envelope they belong. Affix to the appropriate card/envelope 
(reprint, if necessary, to maintain adhesive). Print and affix the 
correct label(s) to the initial card/sample. 
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WORKSHEETS 
 
CODIS CASE FILE FORMS 
 
The worksheets approved for use in CODIS Casework can be found on the WSP Portal. 
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